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Installation Guide

Overview
This manual contains the information you need to install and configure the Kingdom software 
and other applications available from the IHS Kingdom website at kingdom.ihs.com. and IHS 
Installation DVD. 

This installation guide includes the chapters listed below. It is recommended that you read the 
chapter Planning your Installation or Upgrade before you begin your installation.

If you need help installing or configuring the software, or if you want the installation DVD 
shipped to you, please contact Customer Care.

Planning your Installation 
or Upgrade

This chapter provides helpful guidance about the different 
Kingdom software and database installations and 
configurations available to you so you can prepare for and 
implement the best solution for your particular requirements.

Downloading and Installing 
the Latest Release

The easiest and fastest way to obtain the latest release is 
from the IHS Kingdom website at kingdom.ihs.com

Installing IHS Kingdom 
Software from a DVD

If you do not have internet connectivity and have received the 
physical media, you can install from the Installation Manager 
on the Kingdom Software DVD.

Installing Third Party 
Software

The four third-party applications are optional installations: 
Adobe Reader, AppSight, SQL Server Express, and SQL 
Management Studio. Adobe Reader is available for download 
from Adobe and from the DVD.

SQL Server Express 
Service Configuration

If you install the Kingdom version of SQL Server Express, you 
need to define how to configure the service according to your 
working environment.

https://get.adobe.com/reader/
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The following links provide more detailed information about installing the SQL Server and 
Oracle clients and the data transfer tool OpenSpirit:

• Installing and Configuring a SQL Server Database

• Installing and Configuring the Oracle Host and Client

• Installing OpenSpirit Client on Kingdom Workstation

Installing the Administrator 
Console

The Administrator Console is intended for use by system 
administrators responsible for defining access permissions to 
Kingdom projects on an enterprise-wide scale. Used in 
conjunction with the Enterprise Project Selector, the 
Administrator Console provides system administrators with a 
single means of defining and communicating access to 
Kingdom projects for all Kingdom users.

Downloading and Installing 
GeoSyn

GeoSyn is a separate installation but workflows are integrated 
with Kingdom. The 64-bit version of GeoSyn uses the 
Kingdom license manager.

Installing the Network 
License Server

If you have a new or an existing network license, install the 
Network License Server. This ensures you have the latest 
version installed.

License Requirements and 
Management

Before using the Kingdom software, you must obtain and 
install the sentinel (dongle) for your computer or network 
license server, and enter the feature key codes into the 
standalone or network license control pane.

Updating the Kingdom 
Software

Service Packs and Hot Fixes are available for download from 
the IHS Kingdom website at kingdom.ihs.com.
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Contacting Customer Care
If you have any questions or need to obtain your software on physical media, contact one of 
our Customer Care Centers of Excellence at kingdom_support@ihsmarkit.com or by phone. 
Regional numbers are listed below.

Region Phone

Americas +1 800 IHS-CARE
+1 800 447-2273
+1 303 736-3001

Latin & South America +54 11 43438635
+55 21 2588-8145 (Brazil)

EMEA +44 (0)1344 328 220

APAC +604 291 3600

mailto: kingdom_support@ihsmarkit.com
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Planning your Installation or Upgrade
If you are performing a new installation of Kingdom, prepare for the installation by reviewing 
the Hardware, system, and database requirements. If you are upgrading a previous version 
of Kingdom to Kingdom 2016.1, be sure to read Upgrading projects to Kingdom 2016.1 to 
understand the requirements and consequences of the upgrade before you continue. 

Kingdom 2016.1 is only backward-compatible with Kingdom 2016 and Kingdom 2015 Service 
Pack 4. it is not compatible with earlier versions of Kingdom, which will affect your ability to 
work in and share projects still in versions earlier than Kingdom 2015 Service Pack 4.

Installation checklist
The following checklist provides a summary of the steps and decisions required to 
successfully install Kingdom and any related software, such as the project database, license 
server, and Administrator Console. You can use this checklist as a way to plan, organize, and 
keep track of your installation.The steps you need to complete vary depending upon your 
requirements and any previous installation of Kingdom you may have.

1. Define hardware, system, and database requirements

2. Choose a database

3. Download the latest software

4. Install the downloaded software or install software from DVD 
(you can also perform a silent installation)

5. Install and configure database

• SQL Server Express

• SQ L Server or Oracle

6. Install Administrator Console (optional)

7. Install License Server (optional)

http://kingdom.ihs.com/DOWNLOADS/IHSKingdom/LatestReleases.aspx
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Hardware, system, and database requirements

Hardware, system, and database requirements
The Kingdom client software has the following hardware, system and database requirements:

Hardware

• Minimum: 64-bit quad-core machine with 8 GB of physical RAM
• Recommended: 64-bit processor with 8 CPU cores and 16 GB of physical RAM or higher
• Recommended: Graphics card: Video cards that support CUDA 4.x have at least 1 GB of 

graphic card memory

Operating Systems Install Support

Windows 7 SP 1 (64-bit) Yes Yes

Windows 8 Yes, 1 Yes, 1

Windows 10 Yes Yes

Windows 2008 R2 Server (Citrix based applications) Yes, 1 Yes, 1

Windows 2012 Server (Citrix based applications) Yes, 1 Yes, 1

Databases Install Support

Oracle (User Installation) 10G and 11G  
(The client and server should be the same version.)

3 Yes

Oracle (User Installation) 12C 3 Yes, 2

SQL Server (User Installation) 2008 R2 3 Yes

SQL Server (User Installation) 2012 3 Yes

SQL Server Express 2008 R2 SP1 Yes Yes

SQL Server Express 2012 SP2  
(Kingdom is not compatible with SP3)

Yes Yes

Access No No

Third Party Software

TIBCO OpenSpirit 4.0.3 (Required for Tunnel O and Kingdom Connect)

Install Kingdom can only be installed on systems with supported operating systems.
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Hardware Requirements for Fault Attributes
Fault Attributes utilizes algorithms to generate 3D seismic attributes that are specifically 
tuned for fault and fracture interpretation. These attributes further extend the existing 
Kingdom Illuminator technology and involve intense computations. For faster computation, 
these algorithms take advantage of NVIDIA CUDA technology and utilize available graphics 
processing unit (GPU) power on video cards.

At a minimum, video cards need to support CUDA 4.x, have at least 1GB of graphic card 
memory, and be updated with the latest video driver supporting Open GL 2.0+. 

The new Fault Attributes algorithms will still run on the regular central processing unit (CPU) 
on computers with graphics cards that do not satisfy the minimum requirements, but 
performance might not be optimal depending on the available CPU power.

License Server
If you want to use a network license server, you need to install or upgrade the license server 
to version 8.5.5. Version 8.5.5 of the license server is a 64-bit application and requires a 64-
bit computer. If you are upgrading your license server, be sure you upgrade on a 64-bit 
computer. For more information about installing or upgrading the license server, see Installing 
the Network License Server.

Related topics
Installation checklist
Required database permissions

Support Full release testing completed for major releases, standard level of testing for 
service pack and hot fixes

Notes 1 IHS provides basic support; we do not certify on these operating systems 
or databases but will provide Customer Care support and consider bugs 
found during installation.

2 IHS is currently testing; we do not certify or currently support

3 IHS provides SQL Server Express 2012 SP2 executable as a download 
from the Kingdom product website, and on the DVD. other database 
servers are provided, installed, and maintained bu the client.
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Required database permissions

Required database permissions
The permissions required to upgrade differ depending on the Kingdom database you are 
using. For projects in SQL Server and Oracle databases, you must enter your database log in 
credentials before upgrading a project.

Related topics
Installation checklist
Hardware, system, and database requirements

Database Required Permissions

SQL Server Express 
(Kingdom-specific version)

No special permissions required

SQL Server Db_Owner 

Or 

Db_Ddladmin + Db_Datareader + Db_Datawriter
For more information, refer to the available Microsoft 
documentation.

Oracle Default roles:
• Connect + DBA 

Customized roles:
• Read/write data for all project tables
• Make DDL statements for schema
• Execute PL/SQL statements
For more information, refer to the available Oracle 
documentation.
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Choosing a database
All Kingdom software features and modules support MS SQL Server Express, MS SQL 
Server, and Oracle databases.

Note: he Kingdom software is not certified on Oracle Express

SQL Server Express This is Microsoft’s free replacement of Access with a database size 
limit of 10 GB for SQL Server Express 2008 R2 and 2012 SP2. 
There is also a 1 GB limit for the memory cache, which limits 
database efficiency with more than three or four users, especially 
when accessing projects with large amounts of well data. For more 
information, see Understanding SQL Server Express.
Kingdom 8.8, Kingdom 2015, Kingdom 2016, and Kingdom 2016.1 
can run on SQL Server Express version 2008 R2 and 2012 SP2.

Important: Once you open a project using SQL Server Express 
2012 SP2, that project can no longer be opened in 
earlier versions of SQL Server Express.

SQL Server The SQL Server client and server need to be purchased and 
installed separately and works only on Windows operating systems. 
Theoretically, there are no limitations to the size of the database. 
SQL Server has multiprocessor support capability. For more 
information about using SQL Server for your Kingdom database, 
see the Database Administration Guide.

Oracle The Oracle client and server Need to be purchased and installed 
separately and can operate on Windows or Unix / Linux operating 
systems. Theoretically, there are no limitations to the size of the 
database. Oracle has multiprocessor support capability. For more 
information about using Oracle for your Kingdom database, see the 
Database Administration Guide.



10 IHS Kingdom® 2016.1

Choosing a database

Database Comparison

Related topics
Installation checklist
Hardware, system, and database requirements
Required database permissions

Database Concurrent 
Users

RAM 
Buffer 

(cached 
records)

No. of 
CPUs

Database 
Size

Database 
Location

SQL Server Express 
(Manual)

~ 4 1 GB 1 10 GB Program 
Files\IHS\KingdomSuite 
folder of SQL Server 
Express computer

SQL Server Express 
(Auto)

~ 4 1 GB 1 10 GB ProjectDatabase folder 
inside project folder

SQL Server  
(Single Project)

~ 80 Limited by 
system 
RAM

Limited 
by 
system

Limited by 
system

SQL Server computer

SQL Server (Multiple 
Project)

~ 80 Limited by 
system 
RAM

Limited 
by 
system

Limited by 
system

SQL Server computer

ORACLE ~ 300 Limited by 
system 
RAM

Limited 
by 
system

Limited by 
system

ORACLE server
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Understanding SQL Server Express
SQL Server Express (SSE) is provided free of charge and it is available from the DVD or as 
an optional download from the IHS website at kingdom.ihs.com.

The Kingdom version of SQL Server Express available on the DVD and from the IHS website 
has a dedicated SMTKINGDOM instance with a pre-configured user name and password to 
simplify installation and integration with Kingdom. If you download and install SQL Server 
Express from Microsoft, you need to configure an SMTKINGDOM instance and create the 
required Kingdom user account. For more information, see Creating and configuring an 
SMTKINGDOM instance.

SQL Server Express is a good database choice for small offices and individual users with no 
database administration experience and no database administrator on staff. It is easy to 
administer and automatically creates the Kingdom project database. The Kingdom version of 
SQL Server Express is simple to implement because it creates a default SMTKINGDOM 
instance with an SMTKINGDOM login (with sysadmin (sa) permissions) and the password 
$ei$micMicro. However, this standard configuration may not meet your internal security 
policies.

SQL Server Express can only run on Microsoft operating systems. For Linux/Unix servers, 
you need to install Oracle.

There are two database options available when you create a new Kingdom SQL Server 
Express project database:

This section contains the following topics:

• Installation requirements

• Connection requirements for Auto SSE

• How is Auto SSE different from Manual SSE?

• Managing Manual and Auto SSE Projects

• Auto SSE and backward compatibility

Auto SSE Configured to be easily portable by automatically attaching and detaching 
the project database when you open and close Kingdom. As long as all 
data is contained in the project folder, when all authors are out of the 
project, you can copy or move the project without any tools or special 
operations.

Manual SSE Management of Manual SSE projects, including attaching/detaching and 
moving the database, is done through the SSE Management Tool 
available from the Kingdom Start Page.
With this option you must use the SSE Management Tool to copy or 
move projects.
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Understanding SQL Server Express

Installation requirements
You must either install the IHS version of SQL Server Express or configure your existing 
installation of SQL Server Express to work with Kingdom. The IHS version creates an 
SMTKINGDOM instance with a pre-configured user name and password that Kingdom uses 
to connect to the SQL Server Express database. Installation of this instance should not affect 
existing instances of SQL Server Express installed by other programs. If you choose to 
configure an existing installation of SQL Server Express, see Creating and configuring an 
SMTKINGDOM instance.

If multiple users are going to access your Kingdom projects, you should install SQL Server 
Express on a shared network computer. You must be logged onto the computer where you 
want to install SQL Server Express.

For optimal Kingdom performance, run SQL Server Express on a dedicated computer with at 
least 8 GB of physical memory.

SQL Server Express is available from the following locations:

• IHS Kingdom website at kingdom.ihs.com

• DVD

Note: You only need to install SQL Server Express once. Reinstalling or updating 
Kingdom will not affect SQL Server Express.

Related topics
Understanding SQL Server Express

Connection requirements for Auto SSE
When using the Auto SSE option, successful connectivity depends on the configuration of 
your working environment. The following combinations are supported:

Note: When using Auto SSE, projects on the network cannot connect to a local SSE 
instance. Similarly, local projects cannot connect to an SSE instance on the network.

Working Environment Recommended Database Configuration

• Kingdom projects are on your computer 
or on a colleague’s computer

• You are a single user or have a small 
work group

Install SQL Server Express on the same 
computer as the Kingdom project.
Use a Local Project—Local database 
Instance configuration.

• Kingdom projects are on a shared 
resource on the network

• The Kingdom project and SQL Server 
Express instance are on different 
computers

Install SQL Server Express on a network 
computer, not on your own computer.
Use a Network Project—Network database 
instance configuration
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Local Project—Local database Instance
Your project and your SQL Server Express (SMTKINGDOM) instance are both on your local 
computer or another computer in your work group.

This is the simplest configuration. When you close a project, it is portable.

Network Project—Network database instance
Your project and your SQL Server Express (SMTKINGDOM) instance are both on your 
network - not on your computer. This configuration supports multiple projects on multiple 
computers connecting to a central SQL Server Express instance. Your network administrator 
needs to create a service account for SQL Server Express to use to access your Kingdom 
projects. For more information about installing SQL Server Express and creating the service 
account, see Installing Microsoft SQL Server Express.

Related topics
Understanding SQL Server Express

How is Auto SSE different from Manual SSE?
You have two options available to you when creating a new project database with SQL Server 
Express: Auto SSE and Manual SSE. Auto SSE is designed for easy project portability and 
Manual SSE maintains backwards compatibility with earlier versions of Kingdom. Auto SSE 
differs from Manual SSE in the following ways:

Auto SSE Manual SSE

• Places the project database in the Kingdom 
project directory.

• Places the project database in the 
IHS\KingdomSuite directory under 
Program Files on the computer where the 
SQL Server Express instance is installed.

• Requires a computer that is designated 
as the database server.

• Automatically attaches the database  when 
the first user opens the project.

• Automatically detaches the database when 
the last user exits the project.

• Does not automatically detach or attach 
the project database.

• Requires the SSE Management tool to 
detach or attach the project database.

• Automatically attaches to any available 
SQL Server Express server if the original 
server is unavailable.

• Kingdom database is unavailable if the 
SQL Server database computer is 
unavailable.

• After all users exit the project, you can copy 
or move the project directory, including the 
database, with Windows Explorer.

• After all users exit the project, you must 
use the SSE Management tool to copy or 
move the project directory and database.
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Note: Only data stored inside the project folder is included in any move or copy. Data stored 
outside of the project folder such as seismic files, author files, or tiff images of your 
raster logs, you need to copy separately.

Related topics
Understanding SQL Server Express

Managing Manual and Auto SSE Projects
Kingdom Auto SSE projects are the easiest to manage. The database files are stored in the 
project folder and you can perform file management tasks such as copy, move, backup, and 
delete using Windows Explorer.

The project database for Manual SSE projects is not located in the project folder. To perform 
file management tasks for Manual SSE projects you need to manage both the project 
database and the project files.

You can manage your Manual SSE projects with two tools:

• Manual SQL Server Express Project Management—available from the Kingdom Start 
Page, this utility provides a number of file management options for your Manual SSE 
projects, such as:

• making a project portable

• copying, moving, or deleting a project

• backing up and restoring a project.

• Kingdom Data Management —a data management application with a wide range of 
project inventory and management tools. Kingdom Data Management requires a 
separate license.

The Manual SQL Server Express Project Management tool manages only the SQL Server 
Express database and the files in the Kingdom project folder. By default, Kingdom files are 
saved in the project folder, but if files such as seismic data, author folders, or raster logs have 
been saved in locations outside of the project folder, these files are not included. Before using 

• Cannot connect to Kingdom versions 8.5 or 
earlier.

• Is backward compatible with Kingdom 
versions 8.2 or later. You can attach the 
database using the SSE Management 
tool.

• Supports the following location 
combinations:

- Local Project—Local database 
Instance

- Network Project—Local Instance

- Network Project—Network database 
instance

• Supports mixed mode location 
combinations for your project folder and 
SSE instance. Your project on the 
network can connect to a local instance 
and vice versa.
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the Manual SQL Server Express Project Management tool to manage your project data, 
move all external files into the Kingdom project folder.

Caution: Applying any of the Manual SQL Server Express Project Management tool options 
to an Auto SSE project changes the project to Manual SSE. The project will no 
longer be automatically portable, but will be compatible with Kingdom versions 8.2 
and later. 

Related topics
Understanding SQL Server Express

Auto SSE and backward compatibility
If you want to open an Auto SSE project in Kingdom 8.5 SP1 or earlier, you need to change 
the project to a Manual SSE project using the Manual SQL Server Express Project 
Management tool. Applying any of the Manual SQL Server Express Project Management tool 
options to an Auto SSE project changes the project to Manual SSE. The project will no longer 
be automatically portable, but will be compatible with Kingdom versions 8.2 and later. For 
specific instructions, see Auto SSE and Backward Compatibility in the Database 
Administration User Manual.

Related topics
Understanding SQL Server Express
Kingdom Project Database Conversions
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Upgrading projects to Kingdom 2016.1
Kingdom 2016.1 is only backwards compatible with Kingdom 2016 and Kingdom 2015 Hot 
Fix 4. Once you upgrade to Kingdom 2016.1, any existing projects you try to open with 
Kingdom 2016.1 must be upgraded, and once upgraded, projects are no longer usable by 
any previous versions of Kingdom except Kingdom 2016 and Kingdom 2015 Hot Fix 4.

You can upgrade individual Kingdom projects or you can upgrade multiple projects at the 
same time. We recommend that you create a full backup of any Kingdom project you plan to 
upgrade. The project backup needs to include a database backup as well as any other 
project files (for example, seismic files, grids, horizons, and faults).

To upgrade a single project to Kingdom 2016.1, simply open the project with 
Kingdom 2016.1. Kingdom prompts you to upgrade, and performs the 
upgrade for you automatically if you choose to upgrade.

If you attempt to open an Access-based project, Kingdom 2016.1 prompts 
you to first convert the database and then upgrade the project, and does so 
automatically if you choose to upgrade. If you are unsure of which database 
to choose, see Choosing a database.

To upgrade multiple Kingdom projects to Kingdom 2016.1 at the same time, 
use the Kingdom Project Upgrade Tool. For more information, see 
Upgrading multiple projects..

SQL Server Express 2005 support
Kingdom versions 2015 and later do not support SQL Server Express 2005. To use Kingdom 
2016.1 you must upgrade any projects to SQL Server Express 2008 R2 SP1 or 2012 SP2. 
You can download the Kingdom version of SQL Server Express from the IHS web site at no 
cost.

Previous version support
Kingdom 2016.1 cannot automatically upgrade projects from version 8.6 or earlier. You must 
first upgrade any 8.6 or earlier versions of Kingdom projects to a minimum of version 8.7 
before you can upgrade them to Kingdom 2016.1.

Multi-Project databases
If you are upgrading from a version of Kingdom prior to Kingdom 2016, there are some 
special considerations for Kingdom projects in a multi-project database (one database with 
multiple Kingdom projects) rather than a single project database (a separate database for 
each Kingdom project):

• Once you upgrade at least one project in a multi-project database, you can no longer 
create new projects in that database with prior versions of Kingdom. 

• You cannot create any new projects in a multi-project database until at least one project in 
that database has been upgraded to the current version. However, you can open earlier 
versions of projects with earlier versions of Kingdom. 

For more information about single and multiple project databases, see Choosing a Database 
in the Database Administrator Guide.

Single Project

Multiple Projects
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If you are using Kingdom Data Management (KDM) to copy a project, you cannot copy the 
project into a multi-project database unless at least one project in that database has been 
upgraded to the current version.

Kingdom 2016.1 and Access
Kingdom 2016.1 does not support Access as a project database. If you want to continue 
using projects that are currently in Access, you must convert the project database to SQL 
Server Express, SQL Server, or Oracle, and then upgrade the projects to Kingdom 2016.1. 
You can perform both the conversion and the upgrade simply by opening Access-based 
projects with Kingdom 2016.1. If you must convert an Access project to a different database 
and you are unsure which one to choose, see Choosing a database.

Related topics
Troubleshooting failed upgrades
Custom Coordinate Reference System (CRS)
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Upgrading multiple projects
Kingdom provides the Project Upgrade Tool so you can upgrade multiple Kingdom projects to 
the latest version at the same time. This tool can expedite the upgrade process in 
environments with large numbers of Kingdom projects. See Using the project upgrade tool for 
step by step instructions.

If you are upgrading Kingdom projects with Access or SQL Server Express 2005 databases, 
you cannot use the upgrade tool. For more information see Upgrading Access or SQL Server 
Express 2005 Projects

The illustration below shows the main components of the Project Upgrade Tool window:

List of directories
The list of directories shows any directories containing Kingdom projects that you have added 
to the Project Upgrade Tool. Any projects in these directories display in the list of projects 
below the directory list. You can filter the list of projects by selecting or clearing the check 
boxes next to the directories you want to include or exclude. Click  to add directories to the 
list or  to remove them from the list.

Status Types and Filters
Project databases have four possible statuses:

Ready for Upgrade these databases satisfy the requirements of the Project Upgrade 
Tool and can be upgraded whenever you are ready.
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You can filter the list of projects by selecting or clearing the check boxes next to the different 
database statuses. Clearing a check box hides any databases with that status from the list.

List of projects
The list of projects shows the Kingdom project databases available in the directories selected 
in the list of directories. You can filter the project databases shown in this list by selecting or 
clearing the check boxes for individual directories or for the different database statuses.

The project database list shows the following information:

• Status—Ready for Upgrade, Ineligible, Complete, or Failed

• Project—The name of the Kingdom project

• Database—The project database type (Auto SSE, Manual SSE, SQL Server, Oracle)

• Directory—The location of the project database (click the directory link to open the 
project)

Project databases that require you to provide logon credentials have a key icon  next to 

the project name. Click  and then enter the user name and password of an account that 
has sufficient permissions to update the project database. You have the option to apply these 
credentials to one database or to all selected databases.

Related topics
Using the project upgrade tool
Upgrading multiple projects
Upgrading projects to Kingdom 2016.1

Ineligible these databases do not meet the requirements of the Project 
Upgrade Tool and cannot be upgraded by the tool (usually Access-
based project databases, which can be upgraded individually).

Complete these projects have already been upgraded to Kingdom 2016.1.

Failed these projects have failed a previous upgrade attempt (you can 
learn more about the upgrade failure by clicking Open Log Folder 
and then opening the log file for the specific database).
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Using the project upgrade tool
The Project Upgrade tool is a separate utility that runs independently of Kingdom. We 
recommended that you back up any projects before you upgrade them.

To upgrade multiple projects:

1. From the Start menu, click All Programs > IHS Kingdom [version] > Project Upgrade 
Tool.

2. Read and acknowledge the information on the startup window, and then click Next.

3. Click Add a directory to get started to browse to a directory containing Kingdom 
projects that you want to upgrade. Any Kingdom projects in the directory display in the 
list.

4. If you want to add additional directories with Kingdom projects, click  and browse to the 
directory you want.

5. Select the projects you want to upgrade by selecting the check box next to each project in 
the list. By default all projects are already selected.

6. If you want, you can filter the list of projects by selecting or clearing the check box next to 
the various project status types. If you have added multiple directories, you can also filter 
the list by selecting or clearing directories.

7. If a project name displays a , click the key and enter the user name and password for 
the project database. The Upgrade button remains unavailable until you have provided 
any required database credentials.

8. Click Upgrade. A progress bar displays next to each project as it is being upgraded, and 
the status changes from Ready to Complete for successful upgrades or Failed for any 
failed upgrades.

9. If you want to view the error log for any failed database upgrades, click Open Log Folder. 
Each database has it’s own log file in the log folder.

Related topics
Upgrading projects to Kingdom 2016.1
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Troubleshooting failed upgrades
The most common reasons for a failed project upgrade include the following:

• An unsupported version of Kingdom—You cannot upgrade projects older than Kingdom 
8.6.

• An unsupported version of SQL Server or SQL Server Express—You cannot upgrade 
projects that use SQL Server 2005 or SQL Server Express 2005.

• The project is still attached to SQL Server Express—The project may be in use by 
another Kingdom user or the project did not close properly. 

• Invalid credentials—the database user name and password you provided during the 
upgrade were incorrect or did not have sufficient permissions on the database to 
complete the upgrade.

Other, less common errors include a missing or invalid geocalc.dat file, a corrupted project 
database, or a missing coordinate reference system.

Most common issues are easy to resolve and the error message you receive provides 
resolution instructions (if you are using the Project Upgrade Tool, this information is available 
in the log file). In those cases where an upgrade issue is not easily resolved, you can contact 
Customer Care. Be sure to have the upgrade log file available before you call. To locate the 
log file, click Show Log File in the Upgrade Failed error message or Open Log Folder in the 
Project Upgrade Tool.

Related topics
Upgrading projects to Kingdom 2016.1
Custom Coordinate Reference System (CRS)

Upgrading Access or SQL Server Express 2005 Projects
The Project Upgrade Tool cannot upgrade Kingdom projects using an Access, SQL Server 
2005, or SQL Server Express 2005 database. You can upgrade Access projects individually, 
or you can migrate your Access projects to another database such as SQL Server Express or 
SQL Server, and then use the Project Upgrade Utility to upgrade them. You must upgrade 
any SQL Server 2005 or SQL Server Express 2005 project databases to SQL Server 2008 
R2, SQL Server Express 2008 R2 SP1, or SQL Server Express 2012 SP2 before you can 
upgrade the projects to Kingdom 2016.1. Projects using Access, SQL Server 2005, or SQL 
Server Express 2005 have a status of Ineligible in the Project Upgrade Tool.
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Custom Coordinate Reference System (CRS)

Project > Projection
Previous versions of Kingdom did not provide the complete list of EPSG coordinate reference 
codes, which often required users to create their own custom versions. Kingdom 2015 and 
later versions provide the complete list and we recommend that you select a standard CRS 
before using a custom one. If your project still requires a custom CRS, go to Project > 
Projection > Create Custom Coordinate System. 

Note: The upgrade tool does not convert a custom CRS to Kingdom 2016 format.

Related topics
Upgrading projects to Kingdom 2016.1
Troubleshooting failed upgrades
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Downloading and Installing the Latest Release
This chapter explains how to download Kingdom software from the IHS website and install 
the software on your computer.

Before you begin
Before you begin your installation, be sure to review the following:

We recommend that you close all Windows programs before running the Kingdom setup 
program and that you disable any anti-virus software until the installation is complete.

If you are installing Kingdom from a DVD, see Installing IHS Kingdom Software from a DVD.

Note: If you are using a network license, for the best performance do not install the license 
server and the Kingdom application on the same computer.

Related topics
Downloading software from My Account
Downloading and installing related apps
Downloading additional resources

Planning Guide This topic includes valuable information to help you 
choose the correct version of Kingdom and the correct 
database to suit your business requirements.

Hardware, system, and 
database requirements

Review the required system specifications.
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Downloading software from My Account
Kingdom, Kingdom Data Management, and GeoSyn releases and updates are available for 
download from the IHS Kingdom website at kingdom.ihs.com. You need your user name and 
password for My Account to access software downloads. If you do not have your account 
information, contact Customer Care.

The Related Apps for each product are also available on the Downloads page. Select the 
Related Apps tab below the list of products to view the list of available related applications.

Note: For network licenses, you must install the Kingdom Network License Server on the 
computer designated as the license server and obtain the feature keys before you can 
successfully start the Kingdom software.

To download and install the software:
1. Log on to the computer where you want to install the software as an administrator.

2. Verify the date and time on the computer. If the date and time on the network license 
server or the Kingdom computer are incorrect, you may not be able to check out a 
license.

3. Using a web browser, log on to My Account on the IHS Kingdom website at 
kingdom.ihs.com.

4. Click Downloads.

5. Select the product you want to download and the version and click Download. 

6. When the download is complete, go to the download directory at 
C:\Users\UserName\Downloads

7. Double-click the installation file and then follow the instructions in the installation wizard to 
complete the installation.

The default installation directory for all products is C:\Program 
Files\IHS\KingdomSuite.Each product has its own subfolder within the KingdomSuite 
folder.

Related topics
Installing Kingdom from the DVD
Downloading and installing related apps
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Downloading and installing related apps
The Downloads page on the IHS Kingdom website at kingdom.ihs.com contains optional 
applications and resources for download.

Note: You need your user name and password information for My Account to access the 
downloads. If you do not have your account information, you can contact your 
Kingdom sales representative.

To download and install related apps:
1. Using a web browser, log on to My Account on the IHS website.

2. Click Downloads.

3. Select the product that you want related apps for.

4. Below the list of products select the Related Apps tab.

5. When your cursor hovers over the related app, the blue Download button displays:

6. Select the application you want to download to your computer and click Download. You 
have the following options:

7. If you used a Save option, browse to the location where you saved the file, double-click 
the installation file and then follow the instructions in the installation wizard to complete 
the installation.

The following related applications are available from the IHS Kingdom website at 
kingdom.ihs.com:

Run Automatically starts the Install Wizard for the selected product. Follow the 
wizard to install the product.

Save Saves the download package to the default download folder: 
C:\Users\username\Downloads

Save as Allows you to select the location to save the download package.

SQL Server Express SQL Server Express is a free, lightweight version of SQL 
Server with an IHS-specific configuration to work with 
Kingdom. 

Network License Server the Network License Server is required if you have acquired a 
new Kingdom network license. If you already have a network 
license, we recommend you download and install the latest 
version of the server.
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The following additional related apps are available if you click All immediately below the 
Related Apps tab name:

Related topics
Downloading additional resources
Downloading software from My Account
Installing Kingdom from the DVD

Demo Projects The default installation directory for the demo projects is 
C:\Kingdom Demo Projects.

This folder contains demo projects and two data folders. The 
demo projects require approximately 700 MB of space and 
use SQL Server Express for the project database, so you also 
need to install SQL Server Express to open the demo projects.

Kingdom Gateway [version] 
for Petrel [version]

Provides direct connectivity between IHS Kingdom and Petrel 
software. 

Administrator Console Allows an administrator to specify access to Kingdom projects 
based on Active Directory permissions.

Appsight for [version] AppSight is a tool for resolving problems in Windows and 
.NET applications.

LSinit for [version] Provides a fix for clock-tampering issues when starting 
Kingdom.

Sentinel Drivers and 
Utilities

Links to the SafeNet website where you can download the 
latest drivers for your Kingdom sentinels used to monitor 
Kingdom standalone and network licenses.
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Downloading additional resources
For all products, the Release Notes and additional resources for the selected release are 
available by clicking on the links in the Resources list. 

The following resources, in PDF format, are available from the IHS Kingdom website at 
kingdom.ihs.com with Kingdom Software or Kingdom Data Management selected:

With GeoSyn selected, the Installation Guide is available which includes both installation and 
licensing information.

Related topics
Downloading software from My Account
Downloading and installing related apps
Installing Kingdom from the DVD

Installation Guide Guidance for what database to select and detailed instructions 
for installing and updating Kingdom and Kingdom 
applications. It also includes information about licensing 
requirements and management.

What’s New Details about the new features and enhancements in the 
latest version.

Planning Guide This topic includes valuable information to help you choose 
the correct version of Kingdom and the correct database to 
suit your business requirements.

Feature Key 
Instructions

Brief instructions on how to obtain and install your feature 
keys for the latest version. A full version of the same 
instructions is available in the Kingdom Installation Guide.

Documentation (PDF 
versions)

Printable versions of all available Kingdom software user 
guides. This information is also available through the Help 
menu of each application.

Installing Appsight Instructions on installing and running AppSight.
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Downloading and Installing GeoSyn
Before downloading, please see Version Compatibility and System Requirements for 
information on the GeoSyn <> Kingdom version requirements and required system 
specifications.

Downloading GeoSyn
1. Log in to My Account on the IHS Markit website at kingdom.ihs.com. If you do not have 

My Account credentials please contact Customer Care.

2. Click Downloads. 

3. Under Product select GeoSyn and under Version select 2016.1 

4. Click Download.

5. When the download is finished, click Open to view the GeoSyn folder.

6. The folder contains two subfolders:

Silent installations using the Microsoft Installer (MSI) installation 
file are useful for companies with controlled IT environments that 
centrally manage and deploy software to user computers. Using 
the MSI file for installations must be silent since the MSI does not 
provide a user interface. See Performing Silent Installations for 
more information.

StandAlone Most users install this version, which can be licensed as a 
standalone product (single user) or as a network license (multi-
user).

ClientServer The ClientServer version provides the ability to update multiple 
instances of the software from a central server. This version 
includes a client and a server installation. Each user needs to 
install the client on their computer.
Instead of the ClientServer version, we recommend that you use 
the Microsoft Installer (MSI) described below which utilizes more 
advanced technology. 
If you want to install the ClientServer version, please contact 
Customer Care for details.

MSI Installation 
(silent installation)

Unlike the standard installers, using the MSI does not install any of 
the GeoSyn software prerequisites. You must install these items 
separately. See Installing Prerequisites for details.
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Before you can run the application, you must request a GeoSyn license through the IHS 
license manager. Both standalone and network licenses are available for GeoSyn 
StandAlone. See License Requirements and Management for more information.

Installing GeoSyn StandAlone
The GeoSyn installer includes both GeoSyn 1D and GeoSyn 2D. However, each requires a 
separate license.

Before installing the application ensure that the following requirements are met:

To install GeoSyn StandAlone:
1. After downloading the GeoSyn installation file, open the zip file. The default download 

directory is C:\Users\UserName\Downloads

2. Open the GeoSyn Release folder and select the StandAlone folder. 

3. Right click on the setup.exe file and select Run as administrator. This open the GeoSyn 
InstallShield Wizard. Follow the Wizard.

a. On the Welcome window click Next.

b. Select I accept the terms of the license agreement and click Next.

c. Enter both your User Name and Company Name and click Next.

d. Accept the default installation location or select a different location and click Next.

e. On the Ready to Install the Program window click Install.

4. When installation is complete click Finish to exit the wizard. The installation creates 
GeoSyn shortcuts on the desktop.

Before you can run the application, you must request a GeoSyn license through the GeoSyn 
license manager. Both standalone and network licenses are available for GeoSyn 
StandAlone. See License Requirements and Management for more information.

The user account used to install the product has administrative privileges on the computer.

All GeoSyn users have read/write permissions to the GeoSyn folder.
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Version Compatibility and System Requirements
The following table outlines Kingdom<>GeoSyn version compatibility and supported 
operating systems. Due to Kingdom data model changes, only the product versions paired in 
the table below are compatible.

The GeoSyn 64-bit client software has the following recommended and minimum hardware 
and software requirements:

Kingdom
Release

GeoSyn
Release
(Version)

Supported Operating Systems
License Manager

2016.1 7.1 (64-bit) • 64-bit version only of Windows 7 and Windows 10
• Kingdom license manager. If you have Kingdom and GeoSyn 

versions 2016.0 installed, you do not require new feature 
keys for version 2016.1.

2016 7.0 (64-bit) • 64-bit version only of Vista and Windows 7
• Kingdom license manager

2015 
FP1

6.11 (64-bit) • 64-bit version only of Vista and Windows 7
• Kingdom license manager

2015 6.10 (32-bit) • 32-bit and 64-bit versions of Windows 7, Vista, Windows XP
• AccuMap license manager

8.8 6.9 (32-bit) • 32-bit and 64-bit versions of Windows 7, Vista, Windows XP
• AccuMap license manager

Recommended • Windows 7 64-bit OS or later
• 64-bit quad-core machine with 8 GB of physical RAM or higher 
• 512 MB video system with OPENGL acceleration
• Dual monitor video system

Minimum • 8GB RAM for Vista 64-bit OS or Windows 7 64-bit OS
• 512 MB video system with OPENGL acceleration
• 1280 x 1024 or greater resolution monitor

Supported OS • Windows 10 and Windows 7 64-bit.
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Contacting Customer Care
If you have any questions or need to obtain your software on physical media, contact one of 
Customer Care at Kingdom_support@ihsmarkit.com or by phone. Regional numbers are 
listed below.

Region Phone

Americas +1 800 IHS-CARE
+1 800 447-2273
+1 303 736-3001

Latin & South America +54 11 43438635
+55 21 2588-8145 (Brazil)

EMEA +44 0 1344 328 220

APAC +604 291 3600

Non-Kingdom GeoSyn customers can also contact support.cdn@ihsmarkit.com

mailto: kingdom_support@ihsmarkit.com
mailto: kingdom_support@ihsmarkit.com
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Installing IHS Kingdom Software from a DVD
The information in this chapter applies if you plan to install Kingdom or Kingdom Data 
Management from the Kingdom Software DVD. This chapter provides information necessary 
for the installation and initial start-up of the Kingdom an Kingdom Data Management 
software, and covers the following:

• Kingdom software DVD contents

• Kingdom Installation Manager

The default installation directory for Kingdom, Kingdom Data Management, and GeoSyn is 
C:\Program Files\IHS\KingdomSuite.Each product has its own sub-folder within the 
KingdomSuite folder.

Please note that the fastest and easiest method to obtain and install the latest Kingdom 
update is to download it from IHS Kingdom website at kingdom.ihs.com.
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Kingdom software DVD contents
The Kingdom Software DVD contains the installation files for the following applications:

the following folders and files:

AdministratorConsole The installation files for the Kingdom Administrator 
Console.

GeoSyn The installation files for the standalone and network 
versions of GeoSyn.

InstallPages Files and images used by the Kingdom Installation 
Manager

KingdomDM The installation files for Kingdom Data Management

KINGDOMSoftware The installation files, installation documentation, and 
demo projects for the Kingdom software.

LServer The installation files for the Kingdom License Server.

SMT Product Documentation PDF files of the user manuals for all products. These files 
are copied to your computer during the Kingdom 
installation.

SupportFiles Contains the installation and supporting files for the 
following applications:

• Adobe—Acrobat Reader.

• AppSight—AppSight Black Box captures the root 
cause of application problems.

• GL View—an Open GL shader viewer. This stand 
alone utility helps determine the cause of shader 
problems.

• Microsoft—includes .NET, Report Viewer, and 
Microsoft SQL Server - Express edition.

• Sentinel—the driver for the Sentinel plug, which is a 
hardware device required to run Kingdom software. 
You cannot use Kingdom without a Sentinel plug.

• SQLExpress—The Kingdom installer for Microsoft 
SQL Server - Express edition.

AUTORUN.INF Contains setup information for the installer.
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Related topics
Kingdom Installation Manager
Installing IHS Kingdom Software from a DVD

Release Documents Contains the following product documentation:
• Feature_Key_Instructions.pdf—a brief version of how 

to obtain and install your feature keys for the latest 
version.

• PlanningGuide.pdf—helpful information concerning 
Kingdom installation options and database choices.

• ReleaseNotes.pdf—important information about 
installation, compatibility, configuration, 
enhancements, fixed bugs, and known problems.

• WhatsNew.pdf—an introduction to the new features 
and functionality in Kingdom and Kingdom Data 
Management.

Setup.exe The application executable. Double-click to start the 
Kingdom Installation Manager.

TKS.config Configuration file for the installation.
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Kingdom Installation Manager
Use the Kingdom Installation Manager to install Kingdom, Kingdom Data Management, 
Kingdom applications, and all third party software from the Kingdom DVD. To start the 
Kingdom Installation Manager, place the Kingdom Software DVD into your DVD drive. The 
Installation Manager starts automatically.

The Kingdom Installation Manager contains the following tabs:

• Network license server (The license server is required for 
network license environments and hosts the network 
sentinel)

• Administrator Console

• GeoSyn Standalone

• GeoSyn Network

Related topics
Kingdom software DVD contents
Installing IHS Kingdom Software from a DVD
Downloading software from My Account

Install Kingdom
The Install Kingdom tab includes the following items:

Install Kingdom Install Kingdom and the Kingdom Demo Projects, view the 
Kingdom Installation Guide, or request a trial license.

Install Kingdom DM Install Kingdom Data Management or request a trial license.

View resources View product release and Help documentation

Install third party 
software

Install AppSight, Adobe Reader, SQL Server Express, and 
SQL Management Studio.

Applications Install any of the following related applications:

Install Kingdom Software Click to start the installation wizard and follow the wizard. 
The default installation directory is  
C:\Program Files\IHS\KingdomSuite.
Before you can run Kingdom, you need to obtain and install the 
feature keys that control the licensing. See Obtain and Install 
Feature Keys for details.

Install Demo Projects Click to start the installation wizard for the demo projects included 
with the Kingdom Software.

View Installation Guide The installation guide is in PDF format and requires Adobe 
Reader.
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Related Topics
Kingdom Installation Manager

Install Kingdom Data Management (DM)
Kingdom Data Management (DM) is a data management and data transfer tool that allows 
you to work more efficiently when managing data.

Your Kingdom and Kingdom DM versions must match. For example, if you have installed 
Kingdom 2015 64-bit, you must install Kingdom DM 2015 64-bit.

The Install Kingdom DM tab includes the following items:

Related topics
Kingdom Installation Manager

View resources
The View Resources tab provides quick access to release documents and the full product 
documentation, all in PDF format.

Request a Trial License Click to connect to the Product Evaluation page. Enter the 
required information and send the form to us.

Install Kingdom DM Click to start the installation wizard and follow the wizard. 
The default installation directory is  
C:\Program Files\IHS\KingdomSuite.
Before you can run Kingdom, you need to obtain and install 
the feature keys that control the licensing. See Obtain and 
Install Feature Keys for details.

View Installation Guide The installation guide is in PDF format and requires Adobe 
Reader.

Request a Trial License click to connect to the Product Evaluation page. Enter the 
required information and send the form to us.

Release Notes Provides important information about the current version 
including fixed bugs, known issues, and installation 
information. Please read this document before installing or 
reinstalling the software.

Feature Key Instructions Provides a brief version of how to obtain and install your 
feature keys for the latest version. More detailed instructions 
are available in the chapter License Requirements and 
Management. Point releases do not require new feature keys.

What’s New Includes details the new features and enhancements in the 
latest version.



38 IHS Kingdom® 2016.1

Kingdom Installation Manager

Related topics
Kingdom Installation Manager

Install third party software
Three third party applications are available from the Install Third Party Software tab.

Related topics
Kingdom Installation Manager

Applications
The Applications tab includes the following items:

My Account Links to the many resources available to you on the IHS web 
site, such as the Knowledge Base, software releases and 
updates, and upcoming training classes.

Product Documentation Provides PDF versions of all available Kingdom Software user 
manuals. This information is also available through the Help 
menu of each application: Help > Help Center.

Adobe Acrobat Reader Adobe Reader is required to read and print the PDF user 
manuals and tutorials. If you already have Adobe Reader on 
your computer, the installer identifies the existing application 
version and does not start the installation unless the Adobe 
Reader version on the Kingdom Software DVD is a newer 
version.

Appsight Black Box AppSight Black Box is an effective diagnostic tool for 
diagnosing application problems. See Installing AppSight.

Microsoft SQL Express Installs Kingdom’s customized version of SQL Server - 
Express edition.

SQL Management Studio The Management Studio provides tools to access, configure, 
manage, and administer SQL Server Express.

Install Network License 
Server

Manages site licenses by checking in and out the various 
combinations of license features at your site

The Administrator Console Allows an administrator to manage access to Kingdom 
projects across your enterprise

Install GeoSyn Standalone Installs the standalone version of GeoSyn 1D and GeoSyn 
2D.

Install GeoSyn Network Installs the network version of GeoSyn 1D and GeoSyn 2D.

http://kingdom.ihs.com
http://kingdom.ihs.com
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Related topics
Kingdom Installation Manager
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Performing Silent Installations
Kingdom, GeoSyn, and Kingdom Data Management offer the ability to perform silent 
installations using the Microsoft Installer (MSI) installation file. This is useful for companies 
with controlled IT environments that centrally manage and deploy software to user 
computers. Using the MSI file for installations must be silent since the MSI does not provide a 
user interface.

Unlike the standard installers, using the MSI does not install any of the software 
prerequisites. You must install these items separately. See Installing prerequisites for more 
information.

Microsoft Windows installer service
The Microsoft Windows Installer Service (msiexec.exe) is a service provided by Microsoft 
and included in most Microsoft operating systems. This is the service you use to perform 
software installations with MSI files.

Command Line options and properties
For a list of the command line options available to the Microsoft Windows Installer Service 
(msiexec.exe), see the following article available from Microsoft:

http://msdn.microsoft.com/en-us/library/Aa367988.

Properties
The Microsoft Windows Installer Service has many properties for which you can define 
values. An important property you are likely to use is the INSTALLDIR property, which defines 
the installation directory for the silent installation of an application. For example:

INSTALLDIR=”C:\Program Files\IHS\KingdomSuite”

You use properties at the command line for silent installations. Keep in mind that property 
names are case sensitive.

Sample command lines
Here are some sample command lines for the silent installation of Kingdom and GeoSyn. 
These are provided for reference only. Your own command line requirements may differ 
significantly.

Kingdom

Install to default 
location

msiexec.exe /i “<path to msi>\The Kingdom Software 
2016.1 (64-bit).msi” /quiet

Install to custom 
location

msiexec.exe /i “<path to msi>\The Kingdom Software 
2016.1 (64-bit).msi” 
INSTALLDIR=”C:\MyApps\KingdomSuite” /quiet

http://msdn.microsoft.com/en-us/library/Aa367988
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GeoSyn

Log files
The Microsoft Windows Installer creates log files for each installation in the installing user’s 
Temp directory: C:\Users\<UserID>\AppData\Local\Temp\nnnnnnnn.log. The log file 
name is automatically generated and is different for each installation.

Install to default loca-
tion

msiexec.exe /i “<path to msi>\GeoSyn 2016.1 (64-
bit).msi” /quiet

Install to custom loca-
tion

msiexec.exe /i “<path to msi>\GeoSyn 2016.1 (64-
bit).msi” INSTALLDIR=”C:\MyApps\KingdomSuite” /
quiet
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Using the MSI File for installations
The Kingdom Software 2016.1 (64-bit).msi file and the GeoSyn 2016.1 (64-
bit).msi file are standard MSI files.You can use this file with the Microsoft Windows 
Installer application (msiexec.exe), including all the available command line options 
available to the installer. For more information about the Microsoft Windows Installer and its 
command line options, refer to the available Microsoft documentation. Before installing 
Kingdom 2016.1 using the MSI file, you must first install the software prerequisites. For more 
information, see Installing prerequisites.
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Extracting the MSI file
The MSI files are contained in the standard installation executables and must be extracted 
before you can use them for silent installations. The standard installation executables are 
available for download from the IHS Markit Kingdom website at kingdom.ihs.com as well as 
on the installation DVD:

To extract the Kingdom or Kingdom Data Management MSI file:

1. Download the installation executable from the IHS website or copy the installation 
executable from the installation DVD.

1. At a command prompt, change directories to the location of the application executable 
(.exe) file.

2. Type one of the following, depending on the program you want to extract:

• “The Kingdom Software 2016.1(64-bit).exe” /stage_only

• “GeoSyn 2016.1(64-bit).exe” /stage_only

• “Kingdom Data Management 2016.1(64-bit).exe” /stage_only

3. Press Enter.

4. When prompted, select a destination folder where you want to extract the MSI file.

5. Click Finish to complete the extraction.

The MSI extraction creates several folders with different GUIDs. These folders contain the 
Kingdom or Kingdom Data Management MSI as well as MSI and .exe files for all the 
prerequisite software.

You can move these files to any location you need to perform silent installations.

Note: You can also extract the MSI file directly from the installation DVD without needing to 
copy the installation executable to a computer. Here is a sample command line for 
extracting the Kingdom MSI file from the DVD: 
 
“<DVDRoot>\KingdomSoftware\Kingdom\x64\The Kingdom Software 2016.1 
(64-bit).exe” /stage only

If you need more information about extracting content from the installation executable, refer 
to the InstallShield support documentation.

Kingdom <DVDRoot>\KingdomSoftware\Kingdom\x64\The Kingdom Software 
2016.1 (64-bit).exe

GeoSyn <DVDRoot>\KingdomSoftware\GeoSyn\x64\GeoSyn 2016.1 (64-
bit).exe

KDM <DVDRoot>\KingdomDM\x64\Kingdom Data Management 2016.1 (64-
bit).exe

http://helpnet.flexerasoftware.com/installshield19helplib/helplibrary/SteSetupexeParam.htm
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Installing prerequisites
Kingdom, GeoSyn, and Kingdom Data Management have several software prerequisites that 
must be in place to successfully install either application. The standard Kingdom and 
Kingdom Data Management installation executables include these prerequisites, but they are 
not installed if you perform a silent installation with an MSI file. You must install each 
prerequisite prior to installing Kingdom or Kingdom Data Management. When you extract the 
Kingdom or Kingdom Data Management MSI file from the standard installation executable, 
the prerequisite software is also extracted. For more information, see Extracting the MSI file.

These prerequisites apply to Windows 7 and Windows 10.

Prerequisite Sample Command Line

Microsoft .NET Framework 3.5 SP1 or 
greater 
(dotnetfx35SP1.exe)

dotnetfx35SP1.exe "/q:a /C:\"install /q /
norestart\" /norestart"

Microsoft. NET Framework 4.5.2  
(NDP452-KB2901907-x86-x64-AllOS-
ENU.exe)

NDP452-KB2901907-x86-x64-AllOS-ENU.exe 
"/q:a /C:\"install /q /norestart\" /
norestart"

Microsoft SQL Server 2008 R2 Native 
Client 10.50.1600.1 (x64)  
(sqlncli_x64.msi)

msiexec.exe /i  SQLncl_x64i.msi   /qb

Microsoft SQL Server Management Objects 
10.00.2531 (x64)  
SharedManagementObjects_amd64.msi

msiexec.exe /i 
SharedManagementObjects_amd64.msi /qn /
passive

Microsoft SQL Server System CLR Types 
10.00.2531 (x64) or greater 
SQLSysClrTypes_amd64.msi

msiexec.exe /i SQLSysClrTypes_amd64.msi /
qn /passive

Sentinel System Driver 7.5.1 
sentinel.exe

Sentinel.exe /S /v /qb-! 
REBOOT=ReallySuppress
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Installing the Kingdom Demo Projects
You can download the demo projects from IHS Kingdom website at kingdom.ihs.com or 
install them from the Kingdom DVD. The demo projects require approximately 700 MB of 
space. The demo projects use SQL Server Express for the project database, so you need to 
install SQL Server Express 2008 R2 SP1 or later to open the demo projects. 

Note: You need your user name and password information for My Account to access the 
downloads. If you do not have your account information, you can contact your 
Kingdom sales representative.

To download the Demo Projects:
1. Using a web browser, log on to My Account on the IHS website.

2. Click Downloads.

3. Select The Kingdom Software.

4. Below the list of products select the Related Apps tab.

5. Move your mouse over Demo Projects and click Download.

6. You have the following options:

7. If you saved the download package, you can click Run to start the InstallShield Wizard, or 
you can browse to the location at a later time and double-click the executable 
Web_DemoProjects.exe to start the InstallShield Wizard and then follow the wizard to 
complete the installation.

To install the Demo Projects:
1. On the Welcome screen click Next.

2. On the Setup Type, choose whether to perform a complete or custom installation:

• Complete—installs all available projects and data. The total space required for a 
complete installation of the Demo Projects is approximately 700 MB. 

• Custom—after you specify the installation directory, select the Kingdom demo 
projects and data you wish to install on your computer.

3. On the Choose Destination Location, click Change to specify a different installation 
directory or click Next to accept the default directory. The default location is C:\Kingdom 
Demo Projects.

Run Automatically starts the Install Wizard for the selected product. Follow the 
wizard to install the product.

Save Saves the download package to the default download folder: 
C:\Users\username\Downloads

Save as Allows you to select the location to save the download package.
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4. If you selected Custom as the installation type, select which projects and data you want 
to install.

The following projects and data are available:

Make your selections and click Next to continue.

5. Click Install to continue with the installation.

6. After the files are installed, click Finish.

Note: The demo projects have SQL Server Express databases. You need to install SQL 
Server Express on your machine before you can open the Demo Projects. See 
Installing Microsoft SQL Server Express for details.

BEG This Bureau of Economic Geology project contains the Stratton Field 
3D seismic survey with wells and requires approximately 142 MB.

Golden This Golden Geophysical project contains one 3D survey and four 
2D line and requires 160 MB.

Sooner This US Department of Energy and Diversified Operating 
Corporation reservoir management project contains one 3D survey 
with wells and requires 220 MB.

Data This folder contains the various data items that can be used with the 
data loading tutorials and for general data loading practice and 
requires 183 MB.

Shape Files This folder contains culture layers for the Sooner Project and 
requires 142 MB of space.
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Installing Third Party Software
Third party software
Four third-party applications are available from the Kingdom Software DVD: Adobe Reader, 
AppSight, SQL Server Express, and SQL Management Studio. All except Adobe Reader are 
also available from the IHS Kingdom website at kingdom.ihs.com. You can download the 
reader from Adobe.

See the following topics for detailed installation instructions:

Installing Microsoft SQL Server Express

Installing AppSight

https://get.adobe.com/reader/
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Installing Microsoft SQL Server Express
The Kingdom version of SQL Server Express includes an SMTKINGDOM instance which is 
pre-configured with a user name and password that Kingdom uses to access the database.

You must either:

• download and install the IHS version of SQL Server Express, 

or 

• configure your existing installation of SQL Server Express to work with Kingdom. 

Installation of this instance should not affect existing instances of SQL Server Express 
installed by other programs.

The Default installation location is:

C:\Program Files(x86)\Microsoft SQL Server\MSSQL10_50.SMTKINGDOM 

If you select an alternate destination location, the folder SMTKINGDOM_DATA  is not 
automatically created. First create this folder in the desired location and then direct the 
InstallShield Wizard to this folder.

Note: Shared SQL Server components are also installed in C:\Program Files\Microsoft 
SQL Server\MSSQL10_50.SMTKINGDOM. You cannot change the location of these 
shared files.

Upgrading From SQL Server Express 2005
Kingdom version 2015 was compatible with SQL Server Express 2005. Later versions of 
Kingdom are not compatible with this version of SQL Server. Installing the newer version of 
SQL Server Express upgrades the database for you..

Downloading and installing
The Kingdom version is available from the following locations:

Location Download and Installation Steps

IHS Kingdom 
Website

1. Log in to MyAccount at kingdom.ihs.com.

2. Click Downloads.

3. On the Latest Releases page, select Kingdom.

4. On the Related Apps tab select SQL Server Express.

5. Click Download.

6. Select Save or Run and follow the SQL Server Express 
InstallShield Wizard when the download is complete.



IHS Kingdom® 2016.1 49

Installing Microsoft SQL Server Express 

When installation of the instance is complete, the SQL Server Express Service Configuration 
dialog box opens. Read the contents of this dialog box carefully to determine whether you 
want a local or a network configuration. You can also refer to SQL Server Express Service 
Configuration for more information.

Creating and configuring an SMTKINGDOM instance
If you want to install SQL Server Express from Microsoft rather than installing the version 
available from IHS, you need to create and configure a separate SMTKINGDOM instance if 
you want to use SQL Server Express as a project database. The steps for creating a new 
database instance are similar to those for a new installation of SQL Server Express.

To install a new instance of SQL Server Express and create an SMTKINGDOM 
instance:
1. Download the SQL Server Express installer from Microsoft.

2. Run the installer.

3. Click the Installation link on the left and select the New SQL Server installation option.

4. Confirm the New installation or add shared features option is selected and then click 
Next.

5. Accept the license terms, and then click Next.

6. Accept the default selection of features, and then click Next.

7. Confirm the Named instance option is selected, and then type SMTKINGDOM as the 
instance name.

8. Change the Instance root directory to C:\Program Files\IHS\KindgomSuite, and then 
click Next.

9. Select NT AUTHORITY\SYSTEM as the account name for the SQL Server Database 
Engine Service, and then click Next.

10. Select the Mixed Mode option.

11. Enter and confirm the password you want to use for the system administrator (sa) 
account for the SQL Server Express database. By default the currently logged on user is 
set up as a system administrator account, but you can add and remove accounts as 
necessary. 

12. Click Next, and then click Next again. 

13. Once the new instance is created, click Close.

Kingdom 
Software DVD

1. Insert the Kingdom Software DVD. The Installation Manager should 
open. If not, click setup.exe on the DVD.

2. Select the Install Third Party Software tab.

3. Click Install Microsoft SQL Express.

The SQL Server Express installation wizard starts. Follow the 
instructions in the installation wizard.
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To configure the new SMTKINGDOM instance:
You need to enable TCP/IP on the new SMTKINGDOM instance.

1. From the Start menu, start the SQL Server Configuration Manager.

2. In the left pane of the SQL Server Configuration Manager, expand SQL Server Network 
Configuration.

3. In the left pane, select Protocols for SMTKINGDOM.

4. In the right pane, right-click TCP/IP, and click Enabled on the context menu.

5. Click OK on the warning message.

6. Click SQL Server Services in the left pane.

7. In the right pane, right-click the SQL Server service for the SMTKINGDOM instance and 
click Restart on the context menu.

8. Close the SQL Server Configuration Manager.

To create the SMTKINGDOM user:
Once you create and configure the SMTKINGDOM instance, you need to create the user 
account that Kingdom uses to access databases on the SMTKINGDOM instance.

1. From the Start menu, start SQL Server Management studio.

2. In the Connect to Server window, select the SMTKINGDOM instance, and then click 
Connect.

3. In the Object Explorer, expand Security.

4. Right-click Logins, and then click New Login.

5. In the Login name field, type SMTKINGDOM.

6. Select the SQL Server authentication option.

7. In the Password field, type $ei$micMicro, and then type the same password in the 
Confirm password field.

8. Clear the check box for the Enforce password expiration option.

9. In the left pane, click Server Roles.

10. Select the sysadmin role.

11. Click OK.

12. Close SQL Server Management Studio.

Network database Instance
If you decide to locate your SMTKINGDOM instance of SQL Server Express on your network 
to support access for multiple Kingdom users to a single instance, you or your network 
administrator need to create a service account for SQL Server Express to use to access the 
Kingdom projects on network computers. This is not necessary if you plan to install SQL 
Server Express on the same computer where you have your Kingdom projects. For detailed 
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instructions on configuring SQL Server Express on your network, see Network Project—
Network Database Instance.

Troubleshooting
This section addresses common problems you may encounter when connecting to the SQL 
Server Express database or starting the SQL Server Express service:

• Connecting to your SQL Server Express database

• Unable to start the SQL Server Express service

Connecting to your SQL Server Express database
The following information gives troubleshooting tips for a database migration to SQL Server 
Express. These tips also apply to problems opening an existing SQL Server Express 
Kingdom project.

My Kingdom SSE instance is not listed—when creating a project, you cannot see your 
SQL Server Express instance in the list of available instances.

Error occurred connecting to the database—a general error message when trying to 
create or open a SQL Server Express project could be caused by a number of reasons.

Connection requirements for Auto SSE—if you received an error message when creating 
an Auto SSE project stating that the instance did not have adequate permission to read/
write to the project database file, you may need to change permissions on the project 
directory or change the log on account of the SQL Server (SMTKINGDOM) service.

My Kingdom SSE instance is not listed
If you have already installed the SMTKINGDOM instance of SQL Server Express, either from 
the IHS web, from the Kingdom Software DVD, or by creating your own instance, and you still 
cannot see your instance in the drop down list as in the figure below, there are several 
possible causes.

Before troubleshooting, try typing the installed SQL Server Express instance into the SQL 
Server Connect field. Remember, the instance  have \SMTKINGDOM at the end.
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Click OK to continue.

If you receive an error message see Error occurred connecting to the database

Error occurred connecting to the database
If you get “An error occurred connecting to the database. Would you like to try again?”, 
Click No and try the following solutions:

Problem 1: One of the SQL Server services is not running.

Solution 1: Open the Administrative Tools on the computer where SQL Server Express is 
installed and start the SQL Server service(s). The steps below are for a computer running 
Windows 7. There may be slight differences for different Windows operating systems.

1. Click Start > Control Panel > Administrative Tools.

2. Double-click Services.

3. Scroll down to locate the SQL Server services. Check that SQL Server (SMTKINGDOM) 
and the SQL Server Browser services are started.

4. To start a service, right-click the service in the Status column and select Start.

5. Try opening the Kingdom project again.

Problem 2: The TCP/IP protocols is not enabled.
If the SQL Server Express instance is not local (on your computer), the TCP/IP protocol 
on the remote database instance must be enabled. If the SQL Server Express instance is 
on your machine, this is not an issue.

Solution 2: On the computer where SQL Server Express is installed, open the SQL Server 
Configuration Manager and enable the TCP/IP protocol:

1. Click Start > Programs > Microsoft SQL Server 2008 R2 > Configuration Tools > SQL 
Server Configuration Manager.
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2. Under SQL Server Network Configuration, select Protocols for SMTKINGDOM.

3. In the right panel, check if the TCP/IP protocol is enabled. If it is disabled as in the figure 
above, right click Disabled and select Enable.

4. Restart the database service:

a. In the same Configuration Manager, select SQL Server Services in the left panel. 

b. In the right panel right click SQL Server (SMTKINGDOM) and select Restart.

Note: The default status for this protocol is enabled.

Related topics
Troubleshooting

Unable to start the SQL Server Express service
There are a number of reasons why the SQL Server Express service is unable to start. 
Microsoft returns 24 possible reasons. However, the following are the most common:

The user password is not 
valid

Re-enter the password in the Server Configuration dialog 
box and retry.

The user has not been 
granted local “logon as a 
service” rights

If prompted that the user  be added to the local “logon as a 
service” group, click OK.
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Related topics
Troubleshooting

The domain user is not a 
member of a Group that 
has “logon as a service” 
rights.

Contact your domain administrator. See Network Project—
Network Database Instance for detailed steps.

The user is not in the 
Administrator group on the 
local computer

Add the service account user to the computer where the SQL 
Server Express instance is installed and add to Administrator 
Group

The user logged in to the 
computer is not a local 
administrator

You must be a member of the Administrator group on the 
computer. Contact your domain administrator for assistance.
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Installing AppSight
AppSight is an optional feature that you can install when you install Kingdom and Kingdom 
Data Management. Appsight BlackBox records logs for troubleshooting Kingdom software 
issues. 

Once you have installed AppSight you can record AppSight logs from within Kingdom. Select 
Help > Start Recording.

Download and Install AppSight

Note: If you do not have access to the internet or if you have been sent a DVD, you install 
AppSight from the Kingdom Installation Manager. Select the Install Third Party 
Software tab and click Install AppSight.

To download and install AppSight, follow these steps:

1. Log in to My Account.

2. Click Downloads.

3. On the Latest Releases page, select Kingdom.

4. On the Related Apps tab select AppSight.

5. Click Download.

6. Select Save or Run and follow the AppSight InstallShield Wizard when the download is 
complete.

7. A command window opens and remains open until the installation is complete. Wait until 
the installation is complete. No further action is necessary.

After you have installed AppSight you can record AppSight logs from within Kingdom. Select 
Help > Start Recording.

Related topics
Recording with Appsight

http://kingdom.ihs.com
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SQL Server Express Service Configuration

What is your Working Environment?

Note: You must be an administrator on your computer to run the service configuration 
application. 

One of the following configuration options is required for the Auto SQL Server Express 
configuration and highly recommended for the Manual configuration:

Local

Other users in a work group or network that have permissions to access this computer  also 
be able to work in the Kingdom projects.

Network

You need to get service credentials from your domain administrator before continuing.

See Unable to start the service for troubleshooting tips if you get an error message after 
trying to start the service with the entered log on credentials.

Projects Kingdom projects are on your workstation or on a colleague’s 
workstation.

Users You are a single user or have a small work group.

SQL Server Express 
Service

Install SQL Server Express on the same computer as the 
Kingdom projects. Accept Local as the configuration. Click OK in 
the SQL Server Express Service Configuration dialog box to 
exit.

Projects Kingdom projects are on a shared resource on the network.

Users The Kingdom projects and SQL Server Express instance may be 
on different machines. Multiple users may connect to the same 
SQL Server Express instance.

SQL Server Express 
Service

Install SQL Server Express on a network computer - not on your 
workstation. 

This configuration requires a Network Project—Network 
Database Instance solution.
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Network Project—Network Database Instance
You are in a network environment when your project and your SQL Server Express 
(SMTKINGDOM) instance are both on your network - not on your workstation. This 
configuration supports multiple projects on multiple computers connecting to a central SQL 
Server Express instance.

See What is your Working Environment? for local and network criteria.

Your network administrator needs to do the following:

1. Create user (service account).

2. Add the “Log on as a service right” to the user account.

3. Grant the service account Full Control privileges to Kingdom project directories.

4. Add the service account user to the computer where the SQL Server Express instance is 
installed and add to Administrator Group.

5. Set the service account as the Log On account for the SQL Server (SMTKINGDOM) 
service.

Create user (service account)
Prerequisites:

• Microsoft Administrative Tool Pack is installed on a machine in the domain or you have 
access to the domain controller.

• You have a domain administrator account or service account with permissions to create 
users and modify the default domain policy to create the service account. 

Create the user (service account)

1. On a Windows Domain Controller, open Administrative Tools and click Computer 
Management.

2. Expand Your Domain.

3. Right click Users and select New User.

4. Enter the user account information and click Next.

5. Enter a password and confirm the password.

6. Select Password never expires.

7. Click Create and then Close.

Add the “Log on as a service right” to the user account
1. On a Windows Domain Controller, open Administrative Tools and select Domain 

Security Policy.

2. In the console tree, expand Local Policies and then User Rights Assignment.

3. In the details pane, double-click Log on as a service.

4. If this security setting has not yet been defined, select the Define these policy settings 
check box.
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5. Click Add User or Group and then add the user (service) account you created.

Grant the service account Full Control privileges to Kingdom project directories
Add the service account to the group(s) that have Full Control access to the Kingdom project 
directories—or—share the Kingdom project directories to the user account and give Full 
Control access. For the second option, see How do I share my project directories?

Add the service account to the group(s) that have Full Control access

1. On the Windows Domain Controller, select Start > Programs > Administrative Tools > 
Active Directory Users and Computers.

2. Click Groups to display existing groups. 

3. Right click the selected group and select Add to Group.

4. Click Add.

5. Make sure Service Accounts is displayed under Select this object type and that your 
Domain is displayed under From this location.

6. Enter the name of the service account that you created and click Check Names.

7. When the account is returned, select OK and OK again.

Add the service account user to the computer where the SQL Server Express 
instance is installed and add to Administrator Group
This step can be done by the domain administrator remotely or by any user that is an 
administrator on the computer where SQL Server Express is installed.

Tip: You can use the same service account for other instances of SQL Server Express.

The following procedure is for adding the service account on the computer where SQL Server 
Express is installed

1. From the Start menu, select Control Panel > Administrative Tools.

2. Double-click Computer Management to open the Computer Management MMC console.

3. Expand Local Users and Groups.

4. Right click on Users and select New User.

5. Type the user name and password for the service account you created. These must 
match the service account exactly.

6. Clear the option User must change password at next logon.

7. Select the option Password never expires.

8. Click Create, and then click Close.

9. In the left pane, click Groups

10. In the right pane, double-click Administrators.

11. In the Administrator Properties dialog box, click Add.
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12. In the From this location field, confirm that the location is the local computer, not the 
domain.

13. Type the name of the service account and click Check Names to confirm you have 
selected the correct account.

14. Click OK.

15. If successful, the service account user name displays in the Members list. Click OK.

Set the service account as the Log On account for the SQL Server (SMTKINGDOM) 
service

Note: This step can be done by the SQL Server Express Service Configuration tool installed 
with the instance. The user installing the instance  only need the user name and 
password of the service account.

You must be a local administrator on the computer to set the Log On account.

1. Log in to the network computer where SQL Server Express is installed.

2. From the Start menu, select Control Panel > Administrative Tools.

3. Double-click Services.

4. Right click the SQL Server (SMTKINGDOM) service and select Properties.

5. Click the Log On tab.

6. Select This account and then click Browse.

7. In the Select User dialog box, click Locations. 

8. Expand Entire Directory and select the company domain (network) name. Click OK.

9. Type the name of the service account and click Check Names to confirm you typed the 
correct name.

10. Click OK to return to the Log On tab.

11. Enter and confirm the service account password and click OK.

12. Click Yes in the two messages and OK again in the Log On tab.

13. Restart the service. In the Services list, right click the SQL Server (SMTKINGDOM) 
service and click Restart.

The SQL Server (SMTKINGDOM) service  now be able to access the database files located 
in the Kingdom project folders.

The Kingdom project directories must be shared to the SQL Server (SMTKINGDOM) service 
Log On account (service account).The Log On account must have Full Control permissions to 
the project directories. 

How do I share my project directories?
You must share your project folder on your computer to the Log On account for the SQL 
Server (SMTKINGDOM) service and give this account Full Control permissions.
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1. Contact your network administrator and request the name of the service account that was 
created for the SQL Server (SMTKINGDOM) service.

2. Share your project folder to this service account and give it Full Control permissions.

a. Right click the project folder on your computer and select Properties.

b. Click the Sharing tab and click Share.

c. Type the service account name and click Add. If a matching domain account is found, 
the domain\service account name  appear in the list.

d. Under Permission level, click the down arrow and select Read/Write. Click Share.

Your folder is now shared to the service account. Click Done to exit.

Windows Domain Controller
On Windows Server Systems, a domain controller (DC) is a server that responds to security 
authentication requests (logging in, checking permissions, etc) within the Windows Server 
domain. Windows 2000 and later versions introduced Active Directory.
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Unable to start the service

Unable to start the service
There are a number of reasons why the service is unable to start. Microsoft returns 24 
possible reasons. However, the following are the most common:

The user password is not 
valid

Re-enter the password in the Server Configuration dialog box 
and retry.

The user has not been 
granted local “logon as a 
service” rights

If prompted that the user  be added to the local “logon as a 
service” group, click OK.

The domain user is not a 
member of a Group that 
has “logon as a service” 
rights.

Contact your domain administrator. See Network Project—
Network Database Instance for detailed steps.

The user is not in the 
Administrator group on the 
local machine

Add the service account user to the computer where the SQL 
Server Express instance is installed and add to Administrator 
Group

The user logged in to the 
computer is not a local 
administrator

You must be a member of the Administrator group on the 
computer. Contact your domain administrator for assistance.
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The Administrator Console
This chapter explains how to install the Administrator Console, including the Kingdom 
Enterprise Service and Administrator Console database. If you are using only the 
SeismicDirect Access utility, you only need to install the Administrator Console. You do not 
need to install the Kingdom Enterprise service or the Administrator Console database. These 
components are only required for the Project Access utility.

If you are using the Project Access utility, there is a recommended installation order for all the 
required components. Although you can install the various components of the Administrator 
Console in any order, following the recommended installation sequence will simplify the 
installation process.

If you are installing the components required by the Project Access utility, these installation 
instructions assume you are familiar with the following:

• Microsoft Internet Information Services (IIS) version 6 or greater

• Microsoft SQL Server 2005 or greater

• Creation and configuration of service accounts

• Active Directory users and groups

System Requirements
The following table shows the minimum software and permissions required by the various 
components of the Kingdom Administrator Console.

Installation Sequence
Install the components of the Kingdom Administrator Console in the following order:

1. Administrator Console

2. Administrator Console Database

3. Kingdom Enterprise Service

Component Requirement

Console .NET Framework 4.0

Database SQL Server 2005 (SP3 required) or SQL Server 2008

Kingdom Enterprise Service • IIS 6.0 or greater
• .NET Framework 4.0

Service Account • Read-only permissions to Active Directory
• Read-only permissions to all Kingdom project directories
• Read/write permissions to the root folder of web site
• Member of Windows Authorization Access group
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If you are using only the SeismicDirect Access utility, you do not need to install the 
Administrator Console database or the Kingdom Enterprise Service. You can always install 
these components later if you choose to use the Project Access utility at a later time.

Related topics
Configuring the Enterprise Project Selector
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Installing the Administrator Console 

Installing the Administrator Console
Whether you are using the Project Access utility, the SeismicDirect Security utility, or both, 
the first component you need to install is the Administrator Console. For the SeismicDirect 
Security utility, this is the only component you need to install. You do not need to install the 
Kingdom Administrator Console on a computer where Kingdom is installed.

The Project Access utility will not work until you install the Kingdom Enterprise Service and 
console database. However, you install the Administrator Console first so it is available to test 
connectivity to the database and proper access to Active Directory with the service account. 

To install the Kingdom Administrator Console:
1. If you are installing from the web, download the Kingdom Administrator Console from the 

IHS Kingdom website at kingdom.ihs.com.

If you are installing from the DVD, insert the installation DVD, click the Applications tab in 
the Installation Manager, and then click Kingdom Administrator Console.

2. Follow the instructions in the installer to complete the installation.

Related topics
Installing the Administrator Console Database
Installing the Kingdom Enterprise Service
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Installing the Administrator Console Database

Installing the Administrator Console Database
Follow these steps to install the Administrator Console Database. You only need to perform 
the database installation one time. The Administrator Console database requires SQL Server 
2008 or later.

1. Start SQL Server Management Studio.

2. If it is not already connected, connect to the SQL Server database where you want to 
install the Administrator Console database.

3. From the menu, select File > Open > File, and then browse to the \install\SQL folder 
in the Kingdom Administrator Console installation directory (by default, C:\Program 
Files (x86)\KINGDOMSuite\KingdomAdminConsole\).

4. Open the install folder and then the SQL folder.

5. Open the EpsDataModel.sql file.

6. Execute the query. This creates the KingdomEnterprise database in SQL Server.

Related topics
The Administrator Console
Installing the Kingdom Enterprise Service
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Installing the Kingdom Enterprise Service 

Installing the Kingdom Enterprise Service
The Administrator Console uses the Kingdom Enterprise Service to browse Active Directory 
for users and groups and to store permissions information in the SQL database. The 
Kingdom Project Selector uses the service to query the database for information about 
access to Kingdom projects based on the credentials of the logged on user where the 
Kingdom Project Selector is running.

Creating the Service Account
The Kingdom Enterprise Service requires a service account that has read-only access to any 
directories where you have Kingdom projects and that also has read-only access to Active 
Directory. This service account also requires read/write access to the root folder of the web 
server where you are installing the service. You can either create a new service account with 
these permissions or use an existing service account that has the needed permissions.

Creating the Application
Follow these steps to create the Kingdom Enterprise Service application on your web server. 
These steps are specific to Internet Information Services (IIS) version 7. There may be slight 
differences in this process if you are using a different version of IIS.

1. Browse to the \install\Web\KingdomEnterpriseService folder in the Kingdom 
Administrator Console installation directory (by default, C:\Program Files 
(x86)\KingdomSuite\KingdomAdminConsole\).

2. Copy this folder to the root directory of your web server (for example, 
C:\inetpub\wwwroot\).

3. Start Internet Information Services Manager.

4. In the Connections pane, click Application Pools.

5. In the Actions Pane, click Add Application Pool.

6. In the Name field, type the name of the application pool you want to add (for example, 
KingdomEnterpriseService).

7. In the .NET Framework version list, select .NET version 4.0.

8. Click OK.

9. In the list of application pools, click the application pool you just created (for example, 
KingdomEnterpriseService).

10. In the Actions pane, click Advanced Settings.

11. In the Process Model group, select the Identity property and click [...] to open the 
Application Pool identity dialog box and browse for a service account to use for the 
application pool.

12. On the Application Pool Identity dialog box, select Custom account, and then click Set.

13. Enter the user name and password of the service account you want the Kingdom 
Enterprise Service to use, and then click OK. 

14. Click OK twice to close the open dialog boxes.
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Installing the Kingdom Enterprise Service

15. In the Connections pane, right-click the KingdomEnterpriseService folder (in the 
Sites\Default Web Site folder) and click Convert to Application.

16. In the Add Application dialog box, click Select.

17. From the list, select the application pool you just created (for example, 
KingdomEnterpriseService), and then click OK twice.

Configuring the Database Location and Credentials
In the KingdomEnterpriseService folder you copied to the root directory of your web 
server, open the Web.config file in a text editor. Update the ConnectionStrings element to 
include the server name, database name, user ID, and password for the Administrator 
Console database you created previously.

Testing the Installation
To test whether the Kingdom Enterprise Service is installed and running, open up a web 
browser and type in the following URL:

http://localhost/KingdomEnterpriseService/ProjectSelector/ProjectDiscoveryService.svc

If you are not testing the service on the web server itself, you will need to provide the name of 
the web server in the URL listed above rather than using localhost.

If the service is running, you will see a page with instructions about how to configure 
metadata publishing. Otherwise check to see that you performed the installation correctly. In 
some cases, you may see a 404.3 error, “The page you are requesting cannot be served 
because of the extension configuration.” Refer Troubleshooting for more information about 
how to resolve this issue.

Related topics
The Administrator Console
Installing the Administrator Console Database
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Configuring the Enterprise Project Selector 

Configuring the Enterprise Project Selector
As a system administrator, you may want to pre-configure the Enterprise Project Selector for 
your users so they do not have to specify the location of the Kingdom Enterprise Service. To 
do this, you can modify the Kingdom Administrator Console.exe.config file and 
distribute this modified file to each user installation of the Enterprise Project Selector.

To modify the Kingdom Project Selector.exe.config file, follow the steps below:

1. Open a copy of the Kingdom Project Selector.exe.config file in a text editor (this file 
is located in the root Kingdom installation folder (for example, C:\Program 
Files\KingdomSuite\TKS88\).

2. Make the following changes:

Replace

<appSettings>

<add key="ServiceLocation" value="" />

</appSettings>

With

<appSettings>

<add key="ServiceLocation" value="http://companyServerHere/
KingdomEnterpriseService" />

</appSettings>

Where the value is the URL where you installed the Kingdom Enterprise Service.

3. Save your changes in the copied file.

4. Replace users’ copies of the Kingdom Project Selector.exe.config file with the 
modified version of the file.

Related topics
The Administrator Console
Defining Project Access
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Configuring the Enterprise Project Selector
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Installing the Network License Server
A network license allows projects to be accessed and manipulated simultaneously by multiple 
interpreters under individual authorship. A network license requires installation of the 
Network License Server. A physical sentinel (dongle) must be connected to the computer on 
which the network license server is installed. 

Recommended configuration
• Identify a Windows-based computer on your network as the designated Kingdom network 

license server and install the server components on this computer. The license server is a 
64-bit application and requires a 64-bit computer for installation.

• As a best practice, do not install any other Kingdom applications or software on the 
license server.

• Standard TCP/IP network access must be available on the license server.

• The license server must be up and running for users to access the license; the server 
should be running at all times.

Default installation directory
The default installation directory for the Kingdom network license server is:

C:\Program Files\IHS\KingdomSuite

Installing the License Server
The latest version of the license server, 8.5.5, requires a 64-bit operating system. If you are 
upgrading an existing license server and it is installed on a 32-bit computer, you need to 
install the new license server on a 64-bit computer. After installation you can download new 
feature keys. 

If your current license server is already installed on a 64-bit computer, you need to uninstall 
the current license server before installing the new one. 

If you are upgrading on an existing computer, you can save a copy of the feature key file - 
lservrc - from the existing installation directory. After installing version 8.5.5, copy this file 
into the new installation directory. You can also download new feature keys from the IHS 
Kingdom website.

To download the Kingdom network license server:
1. Log on to the computer where you want to install the Kingdom license server as an 

Administrator.

2. Verify the date and time on this computer. If the date and time on the network license 
server or any computer where Kingdom is installed are incorrect, you may not be able to 
check out a license.

3. Using a web browser, log on to My Account at kingdom.ihs.com.

4. Click Downloads.

5. Select The Kingdom Software.
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6. Below the list of products select the Related Apps tab.

7. Move your mouse over Network License Server and click Download. You have three 
options:

8. If you saved the download package, you can click Run to start the InstallShield Wizard, or 
you can browse to the location at a later time and double-click the executable 
Web_LServer.exe to start the InstallShield Wizard and then follow the wizard to complete 
the installation.

To install the network license server from the DVD:
If you are installing the license server from the Kingdom software DVD, follow these steps:

1. Insert the Kingdom software DVD in the DVD drive. The Installation Manager starts.

2. On the Applications tab, click Install Network License Server.

3. Follow the installation wizard instructions to complete the installation. You may be 
prompted to restart the computer.

Before you can use the Kingdom software, you must:

- Install the Kingdom software on a computer for each Kingdom user. 

- Insert the network sentinel (dongle) on the license server computer.

- Obtain and Install Feature Keys.

Run Automatically starts the Install Wizard. Follow the wizard to install the 
product.

Save Saves the download package to the default download folder: 
C:\Users\username\Downloads

Save as Allows you to select the location to save the download package.
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License Requirements and Management
The Kingdom License Server provides licenses for all Kingdom modules as well as the 64-bit 
version of GeoSyn. There are two versions of the Kingdom License Server:

Standalone
The Standalone license allows users to establish multiple authors within a project to 
differentiate between interpretations; however, a standalone license only allows a single 
author to work in a project at any one time. Users having multiple standalone licenses cannot 
access the same project simultaneously even if the two workstations are networked.

A standalone license allows for the installation of Kingdom software on multiple workstations 
within your company; however, two systems cannot run the software at the same time 
because the Sentinel hardware device must be attached to the system running Kingdom. 
Also note, each computer has a different computer code. A unique feature key code must be 
issued for each system the software is installed on before it can be started.

Network
The Kingdom Network License Server provides licensing for multiple users for Kingdom and 
the 64-bit version of GeoSyn. 

The Network Edition license of Kingdom allows users to:

• Access single or multiple projects, thereby enabling a single project to be viewed and 
manipulated simultaneously by multiple interpreters under individual authorship.

• Dynamically check in and out floating licenses for any number of individual product 
features based on the availability at your site. These licenses are subtracted from the pool 
available at your site.

• Minimize data import/export time by allowing the one-time project configuration to be 
accessible to any of the networked licenses.

Employ CITRIX and Terminal server capabilities. Through these applications users can 
remotely, via a high-speed Internet connection, access Kingdom software

Both license options require a sentinel (dongle). For standalone licenses, the sentinel must 
be plugged in to the computer running Kingdom. For a network licenses, the sentinel must be 
plugged in to the computer running the Network License Server.

After the sentinel is plugged in, you need to retrieve the feature keys for the products you 
have licenses to. See the following topics for details:

Retrieving feature keys for a standalone license

Retrieving feature keys for a network license
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Retrieving feature keys for a standalone license

Note: If you have Kingdom and GeoSyn versions 2016.0 installed, you do not require new 
feature keys for version 2016.1.

After you have installed the software, (Kingdom, Kingdom Data Management, or GeoSyn) 
and plugged in the sentinel to the computer that you installed the software on, start the 
application to open the Standalone License Control Panel where you can install the feature 
keys and view the feature information.

The following instructions are for Kingdom. For GeoSyn and Kingdom Data Management, 
simply replace the application name. The steps are the same.

To retrieve your standalone license feature keys:
1. Click Start > All Programs > IHS Kingdom [version]> Kingdom [version]. 

The first time you start the new version of the software, a Feature Key Error dialog box 
opens displaying the message shown below:

The current license does not support The Kingdom Software base 
features. Do you wish to update the license file at this time?

2. Click Yes to continue.

3. In the Install Feature Keys tab of the Standalone License Control Panel, you have 4 
methods to obtain your feature keys:

Use this option in the following situations:

For the Web and Email methods, you need your Computer Code outlined in red in the 
figure below.

Web Feature Key If your workstation has Internet access, this is the simplest way 
to obtain your feature keys. Just click the button and the 
application does the rest.

Browse Feature Key File
• The feature key code has been sent via email and saved in a 

file on your computer.
• Your computer does not have internet access, and the keys 

have been obtained from a different computer through the 
IHS Kingdom website at kingdom.ihs.com.

Web Copy your computer code. Then go to the Kingdom website to 
get your feature keys.

Email Copy your computer code. Then click the email link to open an 
email. Paste the computer code into the subject field and send.
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Note: If your Computer Code field is blank, make sure your sentinel hardware device is 
attached to your computer.

Feature Information Tab
After you have installed your feature keys, click the Feature Information tab of the 
Standalone License Control Panel to verify the features licensed as well as the start and 
expiration dates of each feature.

The dialog box includes:

• Feature—the licensed stand-alone features on the system.

• Start Date—the day the license was issued.

• Expiration Date—the day the license expires.
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Retrieving your network license feature keys

Note: If you have Kingdom and GeoSyn versions 2016.0 installed, you do not require new 
feature keys for version 2016.1.

After you have installed the software, (Kingdom, Kingdom Data Management, or GeoSyn) 
and plugged in the sentinel to the license server computer, start the Network License Server 
application to open the Network License Control Panel where you can install the feature 
keys and view the feature information.

Requirements and Recommendations
• Identify one computer on your network as the Network License Server. For performance 

reasons, we do not recommend installing the Network License Server and the Kingdom 
Software on the same computer.

• The server can be located on any Windows based PC computer. Supported operating 
systems are 64-bit versions of Windows. See Hardware, system, and database 
requirements for supported operating systems.

• Standard TCP/IP Network must be installed on the system.

• The server must be up and running for users to access the license.

• The client software for Kingdom, Kingdom Data Management, and GeoSyn must be 
loaded locally on each user’s computer.

The following instructions are for Kingdom. For GeoSyn and Kingdom Data Management, 
simply replace the application name. The steps are the same.

To retrieve your network license feature keys:
1. Click Start > All Programs > IHS Kingdom > IHS Network License Server. The 

License Server Control Panel opens to the Configure License Service tab. The License 
Server is registered as a system service the first time this control panel runs.

2. Select the Install Feature Keys tab.

3. Click the down arrow beside Feature Keys for Version to select the version you want to 
license. 

If the latest version is not in the list, click the Add Versions button and add the version. 
The version number must include a decimal. For example, for version 2016 you must 
enter 2016.0.

4. In the Install Feature Keys tab you have 4 methods to obtain your feature keys:

Web Feature Key If your workstation has Internet access, this is the simplest way 
to obtain your feature keys. Just click the button and the 
application does the rest.
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For the Web and Email methods, you need the Computer Code of the license server 
computer. It is outlined in red in the figure below.

In addition to the Install Feature Key tab, the License Server Control Panel contains the 
following 3 tabs:

Browse Feature Key File Use this option in the following situations:

• The feature key code has been sent via email and saved in a 
file on your computer.

• Your computer does not have internet access, and the keys 
have been obtained from a different computer through the 
IHS Kingdom website at kingdom.ihs.com.

Web Copy your computer code. Then go to the Kingdom website at 
kingdom.ihs.com/SUPPORT/Resources/KingdomLicensing 
to get your feature keys. After you have copied the feature 
keys, paste them into Feature Keys panel.

Email Copy your computer code. Then click the email link to open an 
email. Paste the computer code into the subject field and send.
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• Configure License Service 

• Start/Stop the License Server 

• Monitor License Status

Note: If your server has two network cards, then when you configure your server you 
must set up adaptive teaming, or use one network card only.

Related topics
License Requirements and Management
License Server Usage Log File
Initial Startup of Kingdom Using a Network License
Initial Startup of GeoSyn Using a Network License



IHS Kingdom® 2017 79

 

Configure License Service 
The Configure License Service tab displays the paths to the license server executable and 
the site license files, and provides license server startup and disable options.

Note: If your server has two network cards, then when you configure your server you must 
set up adaptive teaming, or use one network card only.

Start Up options
• Start Service at Power Up

The License Server is registered as a system service the first time this control panel runs. 
Setting the Start Service at power up parameter starts the License Service automatically 
at computer start up. This is the default setting and is recommended if you wish to 
continuously run the license server.

• Disable Service:

If the License Service is running, selecting the option Disable Service does not 
automatically stop the service; it marks the service to be disabled. After selecting this 
option you will be able to select Yes to stop the service immediately or No to stop the 
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service when you shut down. When you start your computer again, you will have to select 
Start Service at Power Up to start the server again.

Service Remove / Install.
• Service Remove—removes the License Server as an entry in the system registry. The 

License Server service is stopped and the link to the License Server executable is 
removed from the Windows operating system. 

The License Server executable is not removed from the License Server install directory. 
Once a service is removed from the system registry, the service cannot be started on a 
system boot; it is started when the system restarted. 

• Service Install—restores the License Server Service to the system registry and then 

Start/Stop the License Server
Select the Start/Stop License Server tab to initiate, restart or end the License Server system 
service. You may want to stop and re-start the server to apply patches, or for system 
maintenance.

Monitor License Status
The License Status tab displays the available features, available versions (in the left panel) 
and check out users. Click a particular base product, feature of that product or a user ID to fill 
the information fields displayed on the right side of the panel. 
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Note: The License Status tab can also be reached from the Kingdom Software Start Page 
once the Kingdom software has been installed. Click the License Status/Feature 
Key Maintenance link.

The License Status tab in the Network License Server contains the following elements: 

• License tree: Displays the available features, available versions, checked out version(s) 
and name(s) of the user(s) of the checked out version(s).

Use the scroll bar to navigate the informational window. Click a particular product, a user 
ID, and a feature of that product. The Feature Information and User information are 
displayed on the right of the panel. 

• Base features—all the Kingdom modules require a base feature license. 

- Feature Name—lists all the available base feature combinations. Features listed in 
this area are base modules of the Kingdom interpretation system.

Click to select the base feature for which you have a license and start Kingdom with 
that feature.

- Available Licenses—the number of licenses not in use on the network at this time.

- Total Licenses—the total number of licenses on the network for each base feature. 
The number reflects the total count for all versions of the base product. 
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• Server Information
- Server Name—the logical name of the computer where the license server resides. 

- IP—the Internet Protocol address of the computer displayed in the Server Name 
text field. The IP is part of the TCP/IP (Transmission Control Protocol/Internet 
Protocol) system or protocol for identifying computers on an internet system.

• Feature Information—the information in these fields is relative to the feature highlighted 
in the Feature Tree located on the left side of the License Status dialog box.

• User Information (information displayed if a user is selected in the License Tree.

- User/computer Name—displays the User ID and Computer of the user selected in 
the License Tree.

- Check out time—displays the time the selected user checked out the license for the 
feature selected in the License Tree.

Note: The status of the feature selected in the License Tree does not update automatically. 
Click Refresh to update the status of a selected feature.

Initial Startup of Kingdom Using a Network License
After the License Server has been installed and the feature keys obtained (see Obtain and 
Install Feature Keys), each workstation should automatically see the server when Kingdom is 
started.

1. On the workstation computer, click Start > All Programs > IHS Kingdom > The 
Kingdom Software [version] to start Kingdom. 

Tip: On installation a shortcut for Kingdom Software is created on your desktop. Double click 
the icon to start Kingdom. 

The first time you start the version of Kingdom, the following message is displayed.

A standalone version of IHS Kingdom software requires a sentinel. Install 
the sentinel provided to you by IHS Inc, on a USB port and try again. If 
you have the network version of Kingdom, you can run the software using 
the network license.

Do you want to connect to a network license server?

2. Click Yes. 

Kingdom polls the system for the network server and automatically connects to that 
server to start the application. 

3. On the License Status tab select the base feature you want Kingdom to run from. 

A base feature or combination of base features is required to run Kingdom. (ADV) is 
Kingdom Advanced. All licensed base features are listed on the right of the License 
Status dialog box. 

4. Click Refresh to poll the system for the new license count and update the display in the 
dialog box. 
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Features such as VuPAK, SynPAK and RockSolid are available with the Kingdom base 
product and are added to the feature tree on left of the dialog box as licenses for these 
features are purchased for your site.

Each time one of these dynamic features are selected in a Kingdom session, the license 
server checks out a license of that type. For example, opening SynPAK in the Kingdom 
session checks out one license of SynPAK.

Specifying the Network License Server
If the defined network license server is not available, and if Kingdom cannot find another 
license server, after starting the Kingdom software you are prompted to Specify the Network 
License Server.
Kingdom does not detect the license server if:

• the license server computer is not running,

• the network is down 

• your computer is not connected to the network

• the computer housing the license server is on a different subnet.

If the computer housing the license server is on a different subnet, enter the full computer 
name: MyLicenseServer.<domain name> in the space provided and click OK. If the 
license server computer is running, and the requested licenses are available, then the 
License Status dialog box opens. Select the licensed base feature and click OK to start 
the Kingdom application.

Initial Startup of GeoSyn Using a Network License
After the License Server has been installed and the feature keys obtained (see Obtain and 
Install Feature Keys), each workstation should automatically see the server once the GeoSyn 
software is started.

1. On the workstation computer, double-click on the desktop icon or click Start > All 
Programs > IHS GeoSyn and select 1D or 2D.

2. If the application detects one or more Kingdom Network License Servers on the network, 
the Select License Server dialog box opens with a list of detected servers. Select the 
server and click OK.

If a license server is not detected, a message box opens prompting you to change the 
server name with the Kingdom Network License Server. Click Yes to open the Reset 
Kingdom License Server Name dialog box. Type the server name in the input field and 
click OK. 
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Obtain and Install Feature Keys
For a standalone license, you obtain the feature keys from the Standalone License Control 
Panel accessed when you start Kingdom for the first time.

For network licenses, you obtain the feature keys from the License Server Control Panel 
accessed through the Network License Server application installed on the computer to serve 
as the license server for the networked Kingdom workstations.

Both the Standalone License Control Panel and the License Server Control Panel provide 
four methods to obtain your feature keys:

Web Feature Key Web

Browse Feature Key File Email
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Web Feature Key
If your workstation has Internet access the simplest way to obtain your feature keys is 
through the Web Feature Key option.

1. Click the Web Feature Key button. 

After the authorization is complete, the feature key codes automatically populate the 
Feature keys box. The figure below shows the Feature keys box populated for a network 
license.

2. Click Install to apply the feature keys.

3. Verify the information in the Feature Information tab (Standalone) or License Status tab 
(Network) and click OK to close the License Server Control Panel.

You are ready to begin using Kingdom.

Note: Kingdom Data Management has only one line of text in the Feature keys box as it is a 
single license.
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Browse Feature Key File
Use this option in the following situations:

• The feature key code has been sent via email and saved in a file on your computer.

• Your computer does not have internet access, and the keys have been obtained from a 
different computer through the IHS Kingdom website at kingdom.ihs.com. Note that you 
must obtain the computer code from your computer.

After you have browsed to the file containing the feature keys, open the file, copy the 
contents and then paste them into the Feature key box on the Install Feature Keys tab of the 
License Server Control Panel, or if the file is a *.txt file, you can simply double click the file.

Web
If your workstation does not have Internet access but you have access to a computer that 
does have Internet access, go to IHS Kingdom website at kingdom.ihs.com to request a 
feature key.

Under REQUEST FEATURE KEY enter the required information:

1. Computer Code—copy your computer code from The Install Feature keys tab of the 
License Server Control Panel. For standalone licenses, the computer code can also be 
found in Kingdom under Project > License Status and from the Tools panel on The 
Kingdom Software [Start Page].

2. Version—scroll down and select the version of Kingdom.

3. Click Get Feature Key.

4. Once your keys are returned, copy them and paste into the Feature Keys field on the 
Install Feature Keys tab of the License Server Control Panel. 

5. Click Install to apply the feature keys.

6. Verify the information in the Feature Information tab (Standalone) or License Status tab 
(Network) and click OK to close the License Server Control Panel.

Email
1. Beside Email click the link features@seismicmicro.com to start your Microsoft Outlook 

email with the proper e-mail address and your computer code entered in the subject line.

2. Click Send. When we receive the e-mail, your feature key code is generated and returned 
to you by e-mail. 

3. When you have the feature keys, copy and paste them into a text file, and save. You can 
then return to the License Server Control Panel and select the Browse Feature Key File 
option.

Note: You can also paste the feature keys from the email directly into the Feature keys 
text area in the License or License Server Control Panel.

4. Click Install to apply the feature keys.



IHS Kingdom® 2017 87

Obtain and Install Feature Keys 

5. Verify the information in the Feature Information tab (Standalone) or License Status tab 
(Network) and click OK to close the License [Server] Control Panel.

You are ready to begin using Kingdom.
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License Server Usage Log
A License Server Log File tracks and records all activity against the license server. 

Create License Server Usage Log File
1. Before proceeding, create the following directory on the license server computer:

C:\SMT_LICENSE_SERVER

Caution: Make sure there are no blank spaces in the path name.

2. On the license server computer, choose Start > Run. Enter regedit and click OK to open 
the Registry Editor window.

3. Find the following folder:

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\RainbowTechnologies\Sentinel 
System Driver\CurrentVersion

4. Highlight and select the CurrentVersion folder to display a list in the right side of the 
Registry Editor window.

5. Double-click CommandlineOpts to open the Edit String dialog box.

6. In the Value data text field of the Edit String dialog box, type the string  
-z 1048576 -l C:\SMT_LICENSE_SERVER\SMTLogfile.txt as shown in the figure below:

Note: The alphabetic character before C:\SMT is a lower case L preceded by a hyphen.

7. Click OK to close the Edit String dialog box. In the Registry Editor window choose File > 
Exit to close the Registry Editor window and return to the SMT License Server Control 
Panel dialog box.

8. You must restart the license server to start the logging process. You can restart the 
license server from SMT License Server Control Panel dialog box. Logging is written to 
the C:\SMT_LICENSE_SERVER directory.

License Server Usage Log File variable—Option Descriptions
• -l usage-log-file—specifies the name and location of the license server’s usage log file. 
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Creating the CommandlineOpts registry entry and setting its value enables usage logging 
from the License Server. The specified file path should not contain white spaces. By 
default, usage logging is disabled.

• -z usage-log-file-size—specifies the maximum size of the usage log file. 

The size can be specified in bytes, kilobytes, or megabytes. For instance, -z 2000 means 
2000 bytes, -z 2k means 2 kilobytes, -z 2m means 2 megabytes. The default value is 1 
megabyte. When the maximum size of the file is reached, the license server creates a 
backup log file unless the option to eliminate backup (-x) has been used. 

If log file backups are not disabled by specifying -x, when the log file reaches its 
maximum size the contents of the log file are moved into a new file that has the same 
name as the original log file but which has two numeric digits appended to its name. For 
example, if the original log file is named lserv.log, the first backup file is named 
lserv.log.00. The next time a backup file is created, the new file uses the next available 
backup number (e.g., lserv.log.01).

The maximum number of backup files is 99; you can move existing backup log files to 
another directory and the license server starts again with 00. If clients are connected to 
the license server when the backup file is created, dummy records are created for any 
pending transactions in the backup file; corresponding dummy records are created in the 
new file. The dummy records are identified by the user name LM_SERVER.

• -x—specifies no backup of log file. When the log file reaches the maximum file size limit, 
a new log file is not generated and logging of Kingdom license usage stops.

By default, on overflow of the usage log file, the file contents are moved into a backup file. 
New usage records are then written to the original file until it overflows again. If the -x 
option is specified, the file is not backed up on overflow; instead the license server simply 
stops writing further records to the file.

To view the license server log file:
1. Copy the usage log file SMTLogfile.txt from C:\SMT_LICENSE_SERVER to the 

directory where the license server is installed. 

The default folder location for the license server directory is 
C:\Program Files\IHS\KingdomSuite\IHS Network License Server

2. Double-click the file ShowUsage.bat. 

The usage report file UsageReport.csv is generated and opens automatically.

A B C D E F G H I J K

24 vsmt Mon 11/26/08 10:41:57 2 4 1417 user1 computer1 8.0.2.0

24 v2016 Mon 11/26/08 10:41:57 2 4 1233 user1 computer1 8.0.2.0

31 vsmt Mon 11/26/08 10:55:51 2 5 23111 user2 computer1 8.0.2.0

31 v2016 Mon 11/26/08 10:56:57 2 5 2285 user2 computer1 8.0.2.0
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The Usage Report consists of the following key columns:

A—Product Code. See Table 2.1 below:

B—Version—Version SMT (vsmt) controls the total number of licenses that users can check 
out, regardless of version. Version 2016 (v2016) controls the total number of, in this case, 
2016 licenses that can be checked out. For a detailed description, go to the License Server 

21 v2016 Mon 11/26/08 11:42:57 0 1 1479 user1 computer1 8.0.2.0

36 v2016 Mon 11/26/08 12:11:07 0 1 5561 user8 computer1 8.0.2.0

34 v2016 Mon 11/26/08 13:22:46 1 1 2369 user8 computer1 8.0.2.0

37 v2016 Mon 11/26/08 14:41:57 1 2 566 user8 computer1 8.0.2.0

Product/Module Code Products without a code
(Listed by name)

Geophysics (2d) 22 1DForwardModeling

Geophysics (3d) 23 ColoredInversion

Geophysics (2d and 3d) 21 ColoredInversionEval

Geology 31 FeatureSelector

SynPAK 26 Geosteering

VuPAK 27 GeoSyn1D

Terminal Services 32 GeoSyn2D

Tunnel L+ 33 KingdomConnect

Tunnel O 34 KingdomAdvanced

Rock Solid Attributes 35 KingdomDataManagement

LoadPAK 28 Security

AVOPAK 36 VelPAK

OpenKingdom 37

OpenSpiritOption 39

A B C D E F G H I J K
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Control Panel > License Status tab. Click All Versions and read the explanation in the right 
panel: 

The total license count for All Versions of Geophysics is 12. 
You cannot concurrently checkout more than 12 licenses of Geophysics 
regardless of the Kingdom Software version you are running. Click the actual 
version folder to get details on a specific version. 
For example, lets say you originally bought 5 licenses of version 7.0. You 
decide to upgrade only 3 of these licenses to 7.1. Your total license count 
is still 5. If you run 3 copies of 7.1, you can run a maximum of 2 copies of 
7.0 concurrently giving you a total of 5. If you are not running 7.1, you 
can run 5 copies of 7.0 concurrently still giving you a total of 5. 

C—Day of the Week the license server was contacted. 

D—Date the license server was contacted.

E—Military Time the license server was contacted.

F—Trans—Transaction Type where 0= issue; 1 = denial; 2 = release. 

G—NumKeys—the number of licenses in use after the current request/release.

H—Keylife—how long, in seconds, the license was issued. This value may be 0 or 1 if the 
license server was contacted, but not selected to issue the license. 

I—Windows login of user. requesting license. 

J—Computer name contacting license server. 

K— License Server version. 
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Updating the Kingdom Software
There are two ways to obtain updates for your Kingdom software. You can download updates 
from the IHS Kingdom website or you can request physical media. 

Obtaining software updates from the web
Kingdom releases and updates are available for download from the IHS Kingdom website at 
kingdom.ihs.com. This is the fastest and easiest way to obtain service packs and hot fixes for 
your Kingdom software. If you do not have an internet connection, contact Customer Care to 
request the physical media.

Note: You need your user name and password information for My Account to access the 
downloads. If you do not have your account information, contact your Kingdom sales 
representative. 

To download software updates:
1. Log on to the computer where you want to install the software as an administrator.

1. Using a Web browser, log on to My Account at the IHS Kingdom website.

2. Click Downloads to open the Latest Releases page.

3. Select the product and version that you want to update.

4. Select the Updates tab below the list of products. Available updates are listed. Select the 
update you want to install and click the Download button.

5. In the View Downloads window, select from the following options:

6. If you saved the download package, you can click Open to start the Update Wizard, or 
browse to the location at a later time and double-click the update file (*.msp) to start the 
Update Wizard and then follow the wizard to complete the installation.

Run Automatically starts the Install Wizard for the selected product. Follow the 
wizard to install the product.

Save Saves the download package to the default download folder: 
C:\Users\username\Downloads

Save as Allows you to select the location to save the download package.
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